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1 Introduction
Thank you for purchasing the SQM-LE. You will soon be on your way to collecting scientific data.
The SQM series of products have been used in the following applications:

• Quantitatively comparing the sky brightness at different astronomical observing sites.
• Documenting the evolution of light pollution.
• Setting planetarium dome illumination to mimic the skies that people are likely to experience elsewhere in the city.
• Monitoring sky brightness through the night, night-to-night, and year-to-year for astronomical observation records.
• Determining which nights show the greatest promise for finding the ’faintest fuzzies’.
• Calibrating the effect of sky brightness on qualitative measures such as the Bortle Scale or NELM.
• Investigating how sky brightness correlates with the solar cycle and month-to-month sunspot activity.
• Helping to provide local ground truth for future sky brightness prediction with the Clear Sky Clock.
• Helping CCD users make a correlation between the SQM reading and when the background reaches some ADC

level.
• Assisting Sea Turtle researchers in studying the amounts of light in areas where turtle hatchlings are affected by

artificial lights.
• Researching bird-song synchronization with dawn.
• Researching twilight brightness changes with the addition of external Neutral Density filters. Unihedron offers

adapters to attach such filters onto the meter.

1.1 QuickStart
1.1.1 Setting up the instrument

1. Either connect the SQM-LE meter to your network router with the supplied blue straight-through Ethernet cable,
or directly to your computer with the supplied red crossover cable.

2. Connect to power supply to the SQM-LE and the AC supply.
3. Launch UDM (Unihedron Device Manager software).
4. Click the “Find” button to find attached devices, then click on the SQM-LE that you connected.
5. Click on “Reading” to get a reading from the SQM-LE.

1.1.2 Other software
• If you are using Windows, you may want to use Knightware SQM-Reader from www.knightware.biz/sqm .

• The CD contains examples of software (Perl, Python, etc.) for various functions that connect to the meter.

1.1.3 FITS integration
Some programs (listed below) gather information from the Unihedron Sky Quality meter products and insert that data
into the Flexible Image Transport System (FITS) header.

• MaxPilote (Freeware) incorporates SQM readings from an SQM-LE/SQM-LU into the FITS header while at the
same time provide constant readings in a live and updated Data Window.
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1.1 QuickStart

• CCDAutoPilot

• FITS4Win2 uses the MPSAS keyword for sorting and filtering image files.
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2 Measurements
The SQM-LE provides readings in Magnitudes per square arcsecond, abbreviated as: mpsas, and written mathematically
as mag

arcsec2 .
Mpsas is a logarithmic measurement which means that large changes in sky brightness correspond to relatively small

numerical changes. A difference of 5 magnitudes is a factor of 100 times the intensity. Therefore a sky brightness 5.0 mag
arcsec2

darker corresponds to a reduction in photon arrival rate of a factor of 100.
The following schematic gives a rough idea of how to interpret the readings of the SQM:

Figure 2.1: Mpsas interpretive scale

Magnitudes are an astronomical unit of measure for object brightness. Brighter objects have a lower magnitude and
darker objects have a higher magnitude value. For example; a star that is 6th magnitude is brighter than a star that is
11th magnitude.
The star Vega is used as the reference point of ≈ 0 magnitude. Table 2.1 shows the apparent magnitude of some

commonly known celestial objects.

Table 2.1: Apparent Magnitudes of Known Celestial Objects adapted from [2]

App. Mag. Celestial Object

−26.73 Sun
−12.6 full Moon
−4.7 Maximum brightness of Venus
+0.03 Vega, the original zero point
+6 Faintest stars observable with naked eye

+27 Faintest objects observable in visible light with 8m ground-based tele-
scopes

+30 Faintest objects observable in visible light with Hubble Space Tele-
scope

Arcsecond is the definition of an arc being divided up into seconds as follows.

1. There are 360 degrees in a circle.
2. There are 60 arcminutes in a degree, and 21600 arcminutes in a circle.
3. There are 60 arcseconds in an arcminute, and 1296000 arcseconds in a circle.
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2.1 Getting accurate readings

Square arcsecond (arcsec2) is the area covered by a square measuring 1arcsec× 1arcsec .

Magnitude per square arcsecond is the definition of brightness in magnitudes spread out over one square arcsecond
of the sky. For example; if the SQM provides a reading of 20.00 mpsas, that would be like saying that a light of a 20th
magnitude star brightness was spread over one square arcsecond of the sky.
The ”magnitudes per square arcsecond” numbers are commonly used in astronomy to measure sky brightness. More

details can be found at www.stjarnhimlen.se/comp/radfaq.html
Each magnitude lower (numerically) means just over 2.5 times as much more light is coming from a given patch of sky.

A change of 5 mags/sq arcsec means the sky is 100x brighter.
The darkest we’ve personally experienced with the SQM in a natural clear sky was 21.80.

2.1 Getting accurate readings
Various factors will cause the night sky brightness to fluctuate. Taking more readings will be useful in ruling out spurious
events. The SQM gathers light for at least a one second period, and the brightness report is based on the light that was
accumulated during that time.
At the darkest sites, natural variations in conditions such as airglow and the brightness of the zodiacal light are limiting

factors.

Prevent artificially high (dark) readings by ensuring that there is nothing blocking the view of the sensor. Avoid taking
readings near trees or buildings that may block the sensor.
A reading of greater than 22.0 is unlikely to be recorded, however there are reasons for extra dark readings:

• Cloud or ash covered sky in a remote area where little natural sky brightness can be recorded.

• Uncorrected readings from covered meter like a weatherproof housing.

• Obstructed view like inside a forest, or where large buildings are located within the field of view, or a person or bird
blocking the view.

When the sky is very dark, the meter takes longer to gather enough light to produce a reading. During this time
of light gathering, the reading will remain constant until the meter can start gathering readings fast enough for new
reading-requests.
The readings are averaged in an 8-cell rolling buffer, so it may take a while for the meter to produce a new value of

darkness when obstructions leave the field of view.

Prevent artificially low (bright) readings by ensuring that there are no lighted objects (street lamps, the moon, etc.)
that shine into the sensor at any angle.

2.1.1 Seeing conditions
Scintillation is due to refractive changes in the atmosphere caused by temperature changes at differing heights.
Stars are too small in comparison to the entire SQM field of view, so scintillation is not expected to alter the SQM

reading significantly.

2.1.2 Light pollution
Undesirable artificial light that reaches you is considered to be light pollution. Much of this light comes from outdoor
illumination of parking lots, street lamps, office buildings, advertising signs, etc..
Other causes of extra light in the night sky are listed below:
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2 Measurements

Aurora

Charged particles emitted from the Sun are directed to the poles of the earth by the Earth’s magnetic field. These particles
collide with atoms in the atmosphere and cause light to be emitted. Aiming the meter at the polar regions during Aurora
Borealis (in the North) or Aurora Australis (in the South) will reduce the reading (lighter). Aiming the meter towards
the equator will increase the reading (darker) under these conditions.

Airglow

Airglow is light produced by various phenomenon in the atmosphere which prevent the sky from being totally dark. Effects
of the magnetic poles of the Earth may cause airglow to be brighter near the poles.

The Milky Way

As one goes to sites with darker surface brightnesses, the fraction of the total light received by the SQM-LE which can
be attributed to the Milky Way bulge increases and so the “offset” in mpsas will be larger (due to the Milky Way.)
The northern view of the Milky Way contributes about 0.10 mpsas under 21.5 mpsas (moonless) skies.
The southern view of the Milky Way might be as big an effect as 0.56 mpsas in dark skies where it goes near-overhead.
For more information, see Surface Photometries of the Milky Way (Schlosser+ 1997)

vizier.u-strasbg.fr/ftp/cats/VII/199/ReadMe

Moisture

Clouds, fog, and mist will reflect artificial light back down to the Earth causing a brighter (lower) reading. If there is
no artificial light, then clouds may prevent starlight from coming to you and the reading will be darker (higher). This
extra-dark situation can occur in very isolated areas like mountain tops, the ocean, or the desert. You will have to be
aware of this special situation when analyzing readings.

Volcanic eruptions

Dust released into the atmosphere by volcanoes can reflect light from the surface of the earth back down. In a dark
location this dust will prevent the light from stars and Milky Way and produce a darker (higher) reading.

Zodiacal light

The sunlight reflected off of dust particles in the ecliptic plane of our solar system is called zodiacal light.
The amount of light will be different depending on whether the meter is pointed to the poles or plane of the solar

system. It is likely to have less than 2% effect. The primary reason for this small effect is that the brightest and widest
part of the zodiacal light is nearest the horizon where the SQM has almost no sensitivity (due to it being a primarily
zenith-looking device). The portions at higher altitude are the narrowest and faintest and they would barely creep into
the sensitivity cone of the SQM.

2.1.3 Other luminance scales
Candela per square meter (cd/m2) is commonly used by lighting engineers.
To convert the SQM mpsas reading to cd/m2, use Equation (2.1):

[cd/m2] = 10.8× 104 × 10(−0.4×[mag/arcsec2]) (2.1)

Naked eye limiting magnitude (NELM)
Quite often astronomers will refer to a sky by the darkest star they can see, for example a “6th magnitude sky”, in that

case you can see 6th magnitude stars and nothing dimmer like 7th magnitude stars. The term “6th magnitude skies” is
very subjective to a person’s ability to see in the night, for example an older person might say “5th magnitude skies” but
a young child with better night vision might say “7th magnitude skies”.
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2.1 Getting accurate readings

No one has performed the task of defining a relationship between the two methods of sky brightness ( x magnitude
skies and magnitudes per square arcsecond) – probably because one is subjective and the other is objective and a wide
variety of people would have to be polled.
An approximation exists for the conversion between NELM and MPSAS. You can use an NELM converter[5] created

by SQM user K. Fisher to do that conversion, or the chart shown in Figure 2.2 and Equations (2.2) and (2.3).

Figure 2.2: Mpsas vs NELM

Convert NELM (V mags) to MPSAS (B) sky brightness [3]

Bmpsas = 21.58− 5× log(10(1.586−NELM/5) − 1) (2.2)

Convert MPSAS (B) sky brightness to NELM (V mags) [4]

NELM = 7.93− 5× log(10(4.316−(Bmpsas/5)) + 1) (2.3)

NSU

Natural Sky Units [1] (NSU) is radiance relative to an assumed natural radiance of 21.6 magSQM/arcsec2 .
NSU values indicate how much brighter or darker the sky is compared to a typical historic clear night sky. It is defined

here as NSU = 100.4∆ where ∆ is 21.6 minus the observed value in magSQM/arcsec2.
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3 Theory of operation

Figure 3.1: SQM-LE Block diagram

3.1 Light measurement
The SQM-LE measures the darkness of the night sky to provide readings of magnitudes per square arc second through
the Ethernet connection.
A light to frequency sensor (TSL237) provides the micro-controller with a signal whose frequency depends on the

amount of incoming light. And, readings from the temperature sensor are used to compensate the light sensor readings
through the range of operating temperatures.
In bright skies, the sensor produces a high frequency square wave (up to 500kHz). As the sky gets dark, the sensor

produces a low frequency. In absolute darkness, the sensor period is very long, and is defined on the calibration sheet as
“Dark period” with a 300s timeout.
Measurement of this wide range of frequencies is done by timers and counters inside the microprocessor. It is difficult for

a microprocessor to accurately measure the period of high frequency signals, and just as difficult to measure the frequency
of extremely low frequency signals. For this reason the microprocessor has two modes of signal measuring:

Frequency mode: The frequency mode is for bright readings where the frequency is high. The sensor signal is fed
into a counter that is gated at one second intervals to report a frequency measured in Hz.

Period mode: The period mode is for dark readings where the frequency is low. The sensor signal gates a high
speed internal counter which reports the period measured in µs.

Both Frequency and Period results are available when connected directly to the meter and using the “rx” command.
The SQM-LE computes mpsas by deciding if the period or frequency report should be used and then compensating for

temperature. Deciding between period or frequency mode reporting was originally done at a frequency of 354Hz, but by
selecting the “Ideal crossover firmware” setting on the “Report interval” page, the switchover will be 679Hz which offers
the best resolution at the switchover point.
The SQM-LE holds the updated period and frequency recordings in memory while waiting for an asynchronous user

request for a reading. It is possible for the user to see stale readings if the light sensor cannot gather enough light to
produce a reading before the user asks for the next report (i.e. using the “rx” command too frequently). Starting at
firmware version 58, the SQM-LE can provide a status of the reading that the user has requested by using the “r1x”
command which contains a status suffix character of F/P/S whose meaning is:

F: fresh FREQUENCY mode reading.

P: fresh PERIOD mode reading.

S: STALE reading indicates that this reading has not changed since the last reading because there was not enough
light gathered to produce a new reading.

16



3.2 Communication to the PC

3.2 Communication to the PC
Commands sent from a PC through the Ethernet cable to the Ethernet interface are relayed to the micro-controller.
The micro-controller responds to commands by sending data strings to the Ethernet interface which are then relayed

to the PC.
Readings are gathered asynchronously by the micro-controller. Requests from the PC are buffered and dealt with as

time permits.
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4 Specifications

Ethernet connection 10/100 Mbit (One connection at a time)
Ports: TCP 10001 (changeable) for data transmission, UDP 30718 for
identification.

Connection timeout Programmable, default = 2 minutes.
Physical Size 3.6” x 2.6” x 1.1”
Meter weight 90g
Power supply weight 100g
Ethernet cable weight 72g
Meter precision Each SQM-LE is factory-calibrated. The absolute precision of each meter is

believed to be ±10% (±0.10 mag/arcsec2). The difference in zero-point
between each calibrated meter is typically ±10% (±0.10 mag/arcsec2)

Field of View The Half Width Half Maximum (HWHM) of the angular sensitivity is ≈ 10◦.
The Full Width Half Maximum (FWHM) is then ≈ 20◦. The sensitivity to a
point source ≈ 19◦ off-axis is a factor of 10 lower than on-axis. A point source
≈ 20◦ and ≈ 40◦ off-axis would register 3.0 and 5.0 magnitudes fainter,
respectively.

Power requirement 5-6VDC 300mA
2.1mmI.D., 5.5mmO.D. connector. Center positive, outside ring negative.

Operating temperature range -40°C to 85°C
Temperature sensor Accuracy: ± 2°C maximum at 25°C

Location: Internal near light sensor, measures internal meter temperature for
light sensor value compensation.

Temperature update rate 4.3 seconds, 256 samples taken at 60Hz then averaged.
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5 Hardware connections
The SQM-LE can be wired directly to a computer with the supplied red crossover Ethernet cable, or it can be wired to a
router with the blue straight-through Ethernet cable. An optional Power over Ethernet (PoE) system can be installed to
eliminate the requirement to have a power supply located right at the SQM-LE location.

5.1 Hardware connections
The SQM-LE requires two connections; power, data.
The power connection is made with the supplied “AC to 5VDC Adaptor”.

Figure 5.1: Connection diagram

5.1.1 Hub/Switch connection
The Ethernet hub/switch connection as shown in Figure ?? is probably the most common method for connecting the
SQM-LE into your system. An Ethernet hub/switch is used to connect the SQM-LE to the same subnet as the PC which
accesses it.
The SQM-LE can serve one TCP connection at a time. Once a TCP connection is made with the PC software, no

other PCs can access that SQM-LE. The TCP connection must be released (or closed) before other PCs can access it.
More than one SQM-LE may be placed on the network, each will have its own IP address.
It is desirable for the SQM-LE to have a fixed IP address so that accessing from the PC is consistent. Assigning the IP

addressing to a fixed value can be done by one of the following methods:

• Using a DHCP router capable of fixing IP addresses to MAC addresses. Note: the SQM-LE MAC address can
be identified with the Lantronix Device Installer software, it is also printed on the Ethernet interface inside the
SQM-LE.

• Use the Windows “Lantronix Device Installer” software available at lantronix.com.

• Telnet into the SQM-LE and follow the Lantronix instructions in the document “Xport_User Guide.pdf” provided
with the SQM-LE CD in the “/SQM-LE/reference” directory.

• Web page access to the SQM-LEs IP address.

19

http://www.lantronix.com/


5 Hardware connections

Figure 5.2: Hub/switch connection

5.1.2 Wireless connection (wireless client bridge)

It is possible to communicate with an SQM-LE using a so-called “wireless client bridge”. In this situation, the PC either
acts like an access point (if it has this capability) or is connected to one by a regular Ethernet patch cable. The Linksys
WRT54GL may be flashed with free, open source firmware from dd-wrt.com and configured either as the wireless access
point or the wireless client bridge.

Figure 5.3: Wireless client bridge connection
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5.1 Hardware connections

5.1.3 More than one SQM-LE

If more than one SQM-LE is required to be accessed on one subnet from another subnet, your router may be able to be
configured for port forwarding to each SQM-LE. Normally port 10001 is used. That default port can be changed using
either the Lantronix Device Installer software or by Telnet into port 9999.

On the LAN side, the SQM-LEs can be addressed like so:

SQM#1 192.168.1.132 10001
SQM#2 192.168.1.133 10001
SQM#3 192.168.1.134 10001
SQM#4 192.168.1.135 10001

If the router is has a dynamic DNS address of sqmcity.dyndns.org then these same SQM-LEs could be accessed from
the Internet in the following way, provided the port forwarding shown in the image was adopted:

SQM#1 sqmcity.dyndns.org 10001
SQM#2 sqmcity.dyndns.org 10002
SQM#3 sqmcity.dyndns.org 10003
SQM#4 sqmcity.dyndns.org 10004

Figure 5.4: Port forwarding example

5.1.4 Direct connection

A direct data connection from the SQM-LE can be made to a PC with the use of an Ethernet crossover cable (included
with the Unihedron SQM-LE purchase). See Figure ??.
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5 Hardware connections

Figure 5.5: Direct connection with crossover cable

The SQM-LE does not come shipped with a fixed IP address, so it may be necessary to fix that address before installing
the unit into such a direct connection system without DHCP server software running. First try connecting to the SQM-LE
without fixing it address, if that fails then you may have to fix the IP address as follows:

1. Install the unit into a DHCP system where the IP addresses are assigned to connected devices.

2. Determine the SQM-LE IP address by querying the router or using the “Lantronix Device Installer” in Windows.
In Linux, you may also use “nmap” to discover connected device IP addresses.

3. Use a browser to go to the SQM-LE IP address as in the following example: http://192.168.1.nnn

4. There is no default username and password, just press OK.

5. The built in Lantronix XPort Device Server Configuration Manager will appear.

6. Select NETWORK from the left side.

7. Select the radiobutton associated with “Use the following IP configuration:”, and enter the IP address that you
would like the unit to occupy in your direct connection system. For example:

IP Address: 192.168.1.141 (assuming that address is free)
Subnet Mask: 255.255.255.0
The “Default Gateway:” field may be left blank.

8. Press “OK” at the bottom then “Apply Settings” on the menu of the left side of the page and the unit will apply
the settings and reboot in about 15 seconds. Since you may have changed the IP address, the web browser will not
respond unless you browse to the new address.

9. The unit is now ready for connection into a non-DHCP system or a direct connection system with a crossover cable.

5.1.5 Power over Ethernet (PoE)

You can use the SQM-LE with an optional PoE system to cut down on the power cable wiring in installations that are
very far (300ft) away from a power cable.
To test the PoE system:

1. Turn off the computer. This is required because Windows sometimes only performs a new device check on locally
connected devices at power up.

2. Wire up the system as shown in figure ??:
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5.1 Hardware connections

Figure 5.6: PoE wiring example

3. Turn on the computer.

4. Start up the Unihedron Device manager (UDM) software.

5.1.6 Lock switch
To prevent undesired alterations to the SQM-LE, the Lock switch should be placed into the ”Locked” position.

Figure 5.7: Lock setting

All versions prevent firmware upgrades and calibration changes with the lock set.
Firmware feature version 42-45 prevent changes to the Report Interval settings with the lock set.
Firmware feature version 46 and above implement optional settings to allow the lock switch to optionall limit access

to the Calibration settings, Report interval settings, Configuration settings, and these same optional settings. See the
Configuration tab in UDM for these settings.
If you are sure that your network is completely secure, then you can set the lock switch to the unlocked position which

allows all remote changes to be made to the SQM-LE.
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6 Software development
The SQM-LE uses the Lantronix XPort Ethernet module to communicate as a standard serial port socket. Many pro-
gramming languages support socket connections to this type of Ethernet connection.
Each SQM-LE has a unique MAC address usually with a prefix of “00-20-4A-…”. This MAC address can be used to

distinguish the exact SQM-LE device from other Ethernet devices.
Also, many routers allow for IP assignment based on MAC address.

6.1 Writing your own software interface
All of the commands and responses of the SQM-LE are documented in Section 8.

To communicate with the SQM-LE, the following general steps are required:

1. A TCP connection must be made to the IP address assigned to the SQM-LE. The default TCP port of access is
10001.

2. If you need to find an SQM-LE on the network; the discovery process involves broadcasting (to 255.255.255.255)
the hex string 00 00 00 F6 to UDP port 30718. The Lantronix XPort will send a response that starts with hex 00
00 00 F7 (elements 1-4), and elements 25-30 contain the MAC address of the responding unit.

3. Data commands are sent to the SQM-LE, and it responds with a string of characters.
4. Close the socket so that other programs can access the SQM-LE. Note: Only one connection can be made to the

SQM-LE at a time. Therefore leaving a connection open constantly prevents other connections from being made.

Various examples of reading from the SQM devices are supplied on the CD and available at the Unihedron website.
Below is an example using Perl to read the SQM Ethernet device:

Listing 6.1: Read SQM-LE using Perl
#!/usr/bin/perl

#Filename: read-sqmle.pl
#Description: Utility to read Unihedron Sky Quality Meter-LE (Ethernet model)

# Define the required module
use IO::Socket;

# Open and configure serial port
$remote = IO::Socket::INET->new(

PeerAddr => '192.168.1.125',
PeerPort => 10001,
Proto => 'tcp');

# Send request to SQM
$remote->send("rx");

# Get response from SQM
$remote->recv($saw,255);

# Close the socket so that other programs can use the SQM
$remote->close;

# Print the SQM result to the screen
printf("%s", $saw);
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6.2 Pascal

The above program prints a result like this:
r,-09.42m,0000005915Hz,0000000000c,0000000.000s, 027.0C

6.2 Pascal
The UDM program contains many examples of finding the SQM devices and reading data from them. It is open source
and written in Lazarus/FreePascal. The source files for UDM are available here:
unihedron.com/projects/darksky/cd/udm/ .

6.3 Custom web page
Details for installing your own web page and Java software can be found at the Lantronix website in their FAQ titled:
Web Enabling Your Serial Device .
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7 Unihedron Device Manager
The Unihedron Device Manager (UDM) program is intended for use in maintaining and testing the Unihedron connected
Sky Quality Meter products. Windows, Mac, Linux versions of UDM area available on the supplied CD. It is used to:

• Read version information.
• Request readings.
• Read and set calibration data.
• Read and set all other meter parameters.
• Install new firmware.
• Setup and retrieve data from datalogging meters.
• Continuously log data from connected meters.

7.1 Getting UDM
UDM is supplied on the CD that shipped with the SQM-LE. The latest version of UDM is available at the Unihedron
website at this location

www.unihedron.com/projects/darksky/cd/

7.2 Installation
7.2.1 System requirements
The UDM is a fairly simple (but large) program which should run sufficiently on any present-day computer under the
Windows, Mac, or Linux operating systems.
The Windows version of UDM can also be run in a virtualization mode using VMware Fusion. Access to the network

is achieved by the menu Virtual Machine > Network Adapter > Bridged (Autodetect) being checked.

7.2.2 Windows
The Windows version of UDM is in a setup.exe style file located in the Windows subdirectory of the CD, for example:
\Windows\setup1.0.0.38.exe
Simply double-click on that file to start the installation procedure.
Note: Some antivirus software may prevent installation of UDM. Try disabling the antivirus software before installing

UDM, or try right-clicking on the setup.exe file and ”Run as admin”.

7.2.3 Mac
The Mac OSX version of UDM is a dmg file located in the Mac subdirectory of the CD, for example:
/Mac/udm.app.dmg
Drag the app to the /Applications directory.

7.2.4 Linux
The Linux version of UDM is available in a Debian package separately for both 32bit and 64bit systems located in the
Linux directory of the CD, for example:
/Linux/udm_20140821-1_i386.deb
Open the file with package installer program like GDebi.
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7.3 Operation
After starting UDM, a list of found devices should appear, if your device is not listed on the screen, try clicking “Find”
once more to search for connected devices.
If more than one SQM device is found, then you will have to select (click) on one of the devices, otherwise if only one

device is found, then click on “Version” or “Reading” of the information tab for more information.
The tabs can be used to select various functions when working with your selected device. These tabs and their functions

are described further in this document.

7.3.1 Start up
After starting the UDM program, a splash screen shown in Figure 7.1 is temporarily shown while the program searches
for attached devices.

Figure 7.1: Splash screen

1. UDM searches for attached USB devices first. This step is fairly quick (a few seconds).
2. UDM then searches for attached Ethernet devices within the reach of the Ethernet network but not outside a firewall.

This step may take about 30 seconds.

If no devices are found, then the main UDM program will be shown with the “found devices box” empty. You can
attach an SQM device to your computer and press the “Find” button to search for the newly connected devices.
If you know that an Ethernet device is connected but it does not show up, then a network problem may be the cause.

Also check the power connection to the SQM-LE.
If you know that a USB device is connected but it does not show up, then there may be a device driver issue. Check

the USB device listing for your operating system. These USB devices should appear as a COMM port. Also, check the
troubleshooting notes in section 13 on page 123 for possible solutions.

7.3.2 Main screen
The main screen of UDM consist of the following sections:
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1. Window controls

2. Menu

3. Found devices box

4. Selected device details

5. Information section

6. Status bar

7.3.3 Main menu

The main menu of UDM consists of the items; File, View, Tools, Help as defined below.

7.3.4 File menu

The file menu is used for: opening files, finding newly attached devices, and quitting the program as shown in Figure 7.2.

Figure 7.2: File menu

File : Open

The “File : Open” menu item is used to open up previously stored log files or calibration reports.
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Figure 7.3: File Open dialog

File : Find USB

The “File : Find USB” function can be used to only find attached USB devices and ignore possible Ethernet devices. The
hotkey Ctrl+U can also be used instead of the mouse.

File : Find Ethernet

The “File : Find Ethernet” function can be used to only find attached Ethernet devices and ignore possible USB devices.
The hotkey Ctrl+E can also be used instead of the mouse.

File : Startup options

The “File : Startup options” function can be used to set the command line startup parameters internally so that these
parameters are not needed on the command line. See 7.14 for more details on the available options.

File : Quit

The “File : Quit” menu item is used to close the UDM program.
The program can also be closed from the window panel “X”.

7.3.5 View menu
The view menu allows you to enable various tabs and check other settings of the UDM program.

Figure 7.4: View menu
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View : Simulation

Click on “View : Simulation” to toggle visibility of the “Simulation” tab. The Simulation tab can be used to send requests
to the SQM-LE to simulate conversions of frequency and period to light meter values. See page 74 for more details.

View : Configuration

Click on “View : Configuration” to toggle visibility of the “Configuration” tab. The Configuration tab is used to configure
the SQM with its calibration values when calibrated light and dark settings are being performed.

View : Log

shows a window of commands and responses sent to and received from the SQM during this session of running UDM.
Some excessively repetitive commands are suppressed from this listing. The hotkey Ctrl+L can also be used instead of
the mouse.

Figure 7.5: View : Log

View : Directories

shows the directory paths used by UDM to store and retrieve data.

Figure 7.6: View:Directories
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Logs Directory Path shows the path where logged records are kept. These logged records are created when using the
“Log one Record” or “Log Continuously” features. Also, log files from data-logging meters will be stored here from the
“Retrieve All” function.
The “Logs Directory Path” path can be changed from its default by pressing the folder button the right. After the

path has been changed, new log files will be stored in that new folder.
UDM operations are logged in files labelled SNnnnn.log and udm.log which are text files that are handy for trou-

bleshooting.

Table 7.2: Default Logs Directory Path

OS Location

Windows

C:\ProgramData\Unihedron\logs\
The Windows File Explorer may hide the directory.
Open File Explorer, click on the “View” tab, and
check the “Hidden items” box.

Linux /home/user/.config/udm/

Mac /Users/user/Documents/udm/

TZ database path The Time Zone information is required for datalogging purposes because the timestamp is logged
as UTC. Since time zones change over the years, the entire Time Zone database is required and hence distributed with
UDM and stored at the displayed “TZ database path”. This path is not changeable.
The Time Zone database is taken from: https://www.iana.org/time-zones

Firmware files path The firmware for the SQM-LE can be updated or reverted using UDM. These firmware files are
stored at the displayed firmware files path. This path is not changeable.

Data Directory is the place where some data files are kept, specifically the change-log for UDM and firmware files. This
path is not changeable.

Configfile path is the place where UDM stores its configuration about the program and attached SQM devices. This
path is not changeable.

Table 7.3: Configfile path

OS Location

Windows C:\ProgramData\Unihedron\udm.ini
Linux /home/user/.config/udm.cfg

Mac /Users/user/Documents/udm/udm.cfg
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View : DL Header shows the Data-logger header editing page. See the information at www.darksky.org/measurements
for a detailed description of each field.

Figure 7.7: Data logging header
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DL : Position can be changed by pressing the Edit button which calls up the following dialog:

Figure 7.8: Set Location dialog

The “Set location” dialog is used to type in your location and have it verified on the world map. Use the following
steps to set the location:

1. Type the exact location coordinates (in degrees) of the SQM-LE into the “Desired” fields.
2. The mouse pointer can be used to select an approximate location if you are not sure of the exact coordinates.
3. The “Elevation” entry is optional as it is not used for anything yet.
4. Press the “Apply” button when you are satisfied with the desired values. Note: The “Apply” button will only be

enabled if there is a difference between the desired and actual values.
5. Press “Close” when you are satisfied with the actual values.

The “Local timezone region” and “Local timezone name” are required by UDM to calculate local times of the recorded
data before storing to disk. UTC timestamps are stored in the SQM-LE.
The cover offset is a text only field that indicates what offset was used on the calibration data of the SQM-LE.
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View : Plotter The plotter window can be used to analyze .dat files recorded by UDM. An example shown below:

Figure 7.9: Plotter window

• The left sidebar tab be expanded and contracted by cliking on the tab title bars.

• Many data points can be optionally included from the “Settings” tab.

• The plotter can also display rise/set Twilight lines for the Sun.

• The “Help” tab shows some hints for zooming and also the line color definitions of plotted lines.

• The bare plot can be saved in vector graphics (SVG) or bitmap (PNG) modes using the “Save” buttons in the
“Settings tab”. Note: SVG plots require that UDM can find the fonts used on the plotter (usually Arial).

View : Plotter : Time offset To assist in correcting timing problems when the datalogger real-time-clock was not
properly set, the Time offset feature can be used as follows if there are two datalogger files, one with proper time set,
and a second with bad time setting:

• Open the Plotter

• File mode: Multiple

• Settings: Display: Grid, and Darkness only, all other display selections can be unchecked.

• Select Plot number: 1, then click on the reference file (with the correct timing).

• Select Plot number: 2, then click on the problem file.
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• Enter a starting time offset value.

• Press Replot.

• Alter the offset and replot until there is overlap of the two lines at a date and time that should be overlapping.

• Record the time offset and use it in the Tools: .dat time correction utility as follows ...

• press ”Select file”, then select the problem .dat file.

• Enter the time difference which you recorded earlier.

• Press ”Correct .dat file”.

View : Plotter : Customized colors and line widths The colors and width of plot lines and can be modified in the
udm.ini/cfg file (found in the View:Directories:ConfigFile path). Edit the file with a text editor and place settings under
the Plotter: section, for example: MPSASColor=clRed
The following names can be used to define plot line colors: MPSASColor MPSAS2Color MPSAS3Color MoonColor

SunColor CivilColor NauticalColor AstronmicalColor SunTwilightColor VoltageColor TemperatureColor
Color names or numbers are defined here: https://wiki.freepascal.org/Colors#Convert_TColor_to.2Ffrom_

string
The width of a line is defined with an integer number of pixels, for example: MPSASWidth=3
The following names can be used to define plot line widths: MPSASWidth MPSAS2Width MPSAS3Width MoonWidth

SunWidth CivilWidth NauticalWidth AstronmicalWidth SunTwilightWidth VoltageWidth TemperatureWidth
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7.3.6 Tools menu
Tools : old log to dat

The “old log to dat” tool is used to convert the original .log files that UDM created before the .dat file was made standard.
Figure 7.10 shows the setup dialog for conversion.

Figure 7.10: Tool : old log to dat

Tools : dat to Moon csv

The “dat to Moon csv” tool is used to convert .dat files to a csv file that contains Moon data using algorithm library
from Andreas Hörstemeier [6]. This tool prepares the file for importation into a spreadsheet like Excel, OpenOffice, or
LibreOffice. For importing into a spreadsheet.
The value for “Moon phase angle” reported in the .csv is:

• 180 or -180 = New Moon
• 0 = Full Moon
• Positive numbers Waxing (growing)
• Negative numbers Waning (shrinking)

Figure 7.11: Tool : dat to Moon csv

Press the “Select ...” button shown in Figure 7.11 to select the file and start the conversion process.

You may also be interested in the “Excel import” instructions listed in section 7.5.1.
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Tools : Comm terminal

The “Comm terminal” is a communication terminal window used for sending manual commands and viewing the response
of the selected (from the found devices window) device.

Figure 7.12: Tool : Comm terminal

Tools : DL retrieve

The “DL retrieve” tool is used for datalogging and Vector model to pull in data files that were stored on disk previously.

Tools : .dat to .kml

Creates a .kml file from a .dat file. This is used when the SQM-LE and an external GPS are read by UDM in the Log
Continuous datalogging mode.

Figure 7.13: Tool : .dat to .kml

The .kml file can be imported into GoogleEarth to create an image similar to this:
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Figure 7.14: Tool : .dat to .kml GoogleEarth result

This tool uses a legend image (kmllegendnewatlas.png.png or kmllegendcleardarksky.png) which must be available to
GoogleEarth to properly display the legend. The resultant .kml file and legend file is stored in the “Logs directory path”.
A minimum set of data can be used by UDM to produce a map with only the MSAS brightness, Latitude,Longitude.

The timestamp
The data file (with .dat extension) requires a definition line which contains at least the following fields:
# UTC Date & Time,MSAS,Latitude,Longitude
A minimum example of a data file showing three data records:

Listing 7.1: .dat minimum field example
# UTC Date & Time,MSAS,Latitude,Longitude
2018-02-07T04:27:57.642;19.0;33.2208;-116.3387
2018-02-07T04:28:17.089;18.3;33.2208;-116.3422
2018-02-07T04:28:37.105;18.0;33.2210;-116.3457

The UTC Datestamp data is not used to make the .kml file, but UDM requires something there.
The format of the fields are:
# YYYY-MM-DDTHH:mm:ss.fff;mag/sqarcsec;Degrees;Degrees

Tools : .dat time correction

Corrects a .dat file for out of synch timing by a manually entered offset. See figure 7.15.
This may be useful when the battery has expired in the datalogging meter, or if the clock was not set at the beginning

of the datalogging session.

Figure 7.15: Tool : .dat time correction

Select the .dat file for correction.
Enter the manual time offset correction (in seconds).
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Press the “Correct .dat file” button to write the corrected file to disk. The location of the new file is shown in the
bottom Filename section.

Tools : .dat reconstruct local time

This tool is used when the datalogger timezone was not set properly. The local timestamp is recomputed for each record
based on the timezone selections. One .dat file or a directory of .dat files can be corrected.

Figure 7.16: Tool : .dat local time reconstruction

Select the desired .dat file or directory of files to reconstruct.
The ”Standard” timezone usage uses a selected timezone region and timzone as the basis for computing the local time

stamp from the existing UTC timestamp.
The ”Custom” timezone usage allows the user to enter a custom time offset in hours as the basis for computing the

local time stamp from the existing UTC timestamp.
Press the “Reconstruct .dat local times” button to start the process.
If a single input file was selected, then the corrected output file will be stored in the same directory with ”_LocalCorr”

appended to the filename.
If a directory of input files was selected, then the corrected files will be stored in a subdirectory called LocalCorr, and

each file will have ”_LocalCorr” appended to its filename.
The reconstructed file(s) will be written to disk at the location specified in the bottom Filename section.

Tools : .dat time correction

If the real-time-clock inside the datalogger was not set properly or the battery was not plugged into the datalogger quickly
enough to keep the super-capacitor charged before datalogging began, then there will be a difference in time when the
data was retrieved. The .dat file can be corrected with this tool.
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Tools : .dat to Sun-Moon-MW-Clouds .csv

Reads a .dat file of SQM data and creates a comma separated value (.csv) file with these attributes at each SQM time
reading.

Table 7.4: .dat to Sun-Moon-MW-Clouds values

Label Description

Location Geographic name of SQM site, taken from ”Location name” in raw data file; if blank
the Location is printed as ”Not-Specified”

Lat Latitude of SQM, in fractional degrees, taken from Position value in raw data file; if
blank, processing will stop

Long Longitude of SQM, in fractional degrees, taken from Position value in raw data file;
if blank, processing will stop

UTC_Date Universal date extracted from raw data file “UTC Date & Time”
UTC_Time Universal time extracted from raw data file “UTC Date & Time”
Local_Date Local date extracted from raw data file “Local Date & Time”
Local_Time Local time extracted from raw data file “Local Date & Time”
Celsius Temperature of SQM, degrees Celsius, extracted from raw data file ”Temperature”
Volts Voltage of SQM, volts (battery supply), extracted from raw data file ”Voltage”
Msas SQM reading (Magnitudes per arc second squared)
Status SQM record type

MoonPhase
Phase of the moon in degrees, 0 degress = Full Moon; + and -180 degrees = New
Moon; waxing Moon from +180 to 0 degrees: waning Moon from 0 to -180 degrees;
values flip from -180 to +180 at Full Moon

MoonElev Elevation angle in degrees of the moon above or below (negative) the local flat horizon
MoonIllum Percentage of moon illuminated
SunElev Elevation angle of the sun above or below (negative) the local flat horizon

MinSince3pm Number of minutes since 3pm of the previous day; allows tracking of time from
afternoon, through evening, night and morning; positive number

Msas_Avg Average value of SQM reading during the current night, under conditions of sun lower
than 18 degrees below the horizon and moon lower than 10 degrees below the horizon

NightsSince_1118 Number of nights since January 1, 2018; useful to track number of nights since that
day

RightAscensionHr Right ascension in hours of the zenith at the SQM location; equivalent to Local
Siderial Time at the SQM location; used to calculate the Galactic orientation

Galactic_Lat
Angle in degrees between the zenith at the SQM location and the highest point of
the Milky Way Arc; value of zero implies the SQM is pointed directly into the Milky
Way

Galactic_Long Angle in degrees from the Galactic Center (Sagittarius) eastward along the Galactic
equator

J2000days Days since January 1, 2000; fractional
Table continued on next page ...
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Table 7.4 – continued from previous page
Label Description

ResidStdErr
Residual Standard Error multiplied x1000; a measure of jaggedness of the SQM data
over a time range specified by the user (typically 90 minutes); if RSE is large, for
example > 50, then conditions can be considered to have been cloudy

ResidStdErr – some details:

Scattered clouds passing overhead cause variations in the SQM brightness readings - a plot over time under a cloudy
sky tends to be very jagged. See Figures 2 and 3 of this report https://5023ce21-5614-48fc-a5d4-292b92640d50.
filesusr.com/ugd/445aec_7522a23976bc472f8dbdcfb907d5d5b7.pdf by Bill Kowalik, and Michael McKeag, Oregon
Chapter of International Dark-Sky Association.

ResidStdErr is a measure of the jaggedness or roughness of the SQM data over time. Large values indicate cloudy
conditions. Small values represent clear conditions. You can later filter out cloudy data by only accepting data points
characterized by a small RSE value.

This cloud estimation algorithm fits a linear regression to the SQM data over a time range. and calculates the Residual
Standard Error (RSE), a measure of the fit between the linear regression and the actual SQM data. See Figure 7.17.
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Figure 7.17: RSE algorithm

We have been using a 90-minute time span as shown in the Figure 7.17. The RSE value is assigned to the point in the
middle of the time span. The time window advances one time step (typically 5 minutes in our data files) and the fit is
calculated for the new center point, etc.
This algorithm processes one day of data at a time. Assuming a 5-minute sample spacing in time, there are at most

288 samples per day, so arrays are dimensioned to 300; attempts to process SQM data with time spacing that provides
more than 300 samples per day will fail.
The Range parameter is the number of samples (usually 5 minutes apart) to include before and after the current point

at which the Residual Standard Error of regression calculation is performed; the full width of the interval in terms of
number of points to consider in the calculation is (2*Range + 1) so that a Range of 6 incorporates a time span of 60
minutes and a Range of 9 evaluates to a 90 minute span.

Additional Notes:

1. If the Latitude and Longitude are not specified in the input .dat file, processing will stop.

2. If the Location name is not specified in the input .dat file, the location name will be printed in the output .csv file
as “Not-Specified”.

42 Unihedron SQM-LE Operator’s Manual - 20260307



7.3 Operation

3. A night sequence is considered to begin at 1500 Local Time.

4. The first Range number of points in a day and the final Range number of points in a day are assigned dummy RSE
values of 999000.0

5. During daylight hours when the entire Range of values has SQM readings of 0.0, the RSE values is reported as 0.0
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Tools : Filter Sun-Moon-MW-Clouds.csv

Reads a csv file created previously by the “UDM/Tools/.dat to sun-moon-MW-clouds.csv” program and allows you to:
a) Filter that csv file for select data records and b) Apply data adjustments. For example, you can set filter parameters
to find data records that were recorded during cloud-free nights. You can apply an adjustment for data recorded because
the SQM was inside a weatherproof case. Data records selected by the filters are written out to two separate csv files,
with keyword labels “Dense” and “Sparse”, as described below.

Parameters:

1. Sun elevation angle cutoff in degrees - includes records with sun elevation angle less than or equal to this value
(default -18.)

2. Moon elevation angle cutoff in degrees - includes records with moon elevation angle less than or equal to this value
(default -10.)

3. Cloud algorithm cutoff - includes records with residual standard error (cloud parameter) less than or equal to this
value (default 20.)

4. Galactic Latitude elevation angle in degrees - cutoff to eliminate Milky Way from FOV, includes records with galactic
latitude greater than this value (symmetric, positive and negative) (default 0.)

5. Correction for weatherproof cover – value subtracted from SQM readings to account for darkening caused by presence
of weatherproof cover (default 0.11)

6. Correction for aging of the SQM - estimate of the increase of brightness reading (darkening) per year due to sunlight
exposure (default 0.01897)

7. Max MPSAS allowed - includes records with MPSAS values less than or equal to this value (default 22.0)

8. Sparse cutoff – after the above filters are applied, segregates data records remaining, which are estimated to be
caused by constant cloud cover, fog, smoke into the “Sparse” output file; the majority of remaining records are
written to “Dense” output file; specify a larger value to segregate more data records; set to zero for no segregation
in which case all remaining records go into the “Dense” output file (default 25)

Explanation of Parameters:

1. Sun elevation – a generally accepted convention is that the sun must be at least 18 degrees below the horizon to
mark the beginning of astronomical darkness

2. Moon elevation – a generally accepted convention is that the moon must be at least 10 degrees below the horizon
to not compromise sky brightness measurements

3. Cloud cutoff – filters on the residual standard error (RSE) attribute previously calculated by the “UDM/Tools/
.dat to-sun-moon-mw-clouds.csv” program. This parameter allows the user to select skyglow measurements taken
during clear, cloud-free, nights. The previously calculated RSE attribute measures the “jagginess” of the skyglow
data over a relatively long time period, for example 90 minutes. If the skyglow data are relatively smooth over that
time period, the sky is assumed to be clear, and the center point of that time range is considered to be a clear sky
measurement. A cloud cutoff of 20 is recommended. To include more data points, use a larger cloud cutoff value.

4. Galactic Latitude – as calculated in “UDM/Tools/ .dat to sun-moon-mw-clouds.csv”, the galactic latitude is defined
as the angle between the zenith at the SQM location and the highest point on the galactic plane. This parameter
allows the user to eliminate any records recorded when the SQM was pointing into the Milky Way. When tabulating
data for certification of dark sky places, we want to eliminate any data recorded when the Milky Way was in the field
of view of the SQM; that FOV is nominally 20 degrees; we suggest a 30-degree cutoff as a conservative approach.
This one value is applied symmetrically on the positive and negative size of the zenith. Choose parameter value of
zero to prevent exclusion of data records on the basis of the galactic latitude.
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5. Correction for weatherproof cover – the presence of the weatherproof cover causes the SQM to read darker values,
which yields a higher mags/arc second squared value; this correction value is subtracted from the SQM reading to
account for the weatherproof cover.

6. Correction for aging of the SQM – Recent research documents that as the SQM devices age over multiple years with
exposure to the sun, that there is a darkening effect on measured data – in other words, the meters read slightly
darker values than they should. This parameter applies a correction to the data based on the progressive age of the
SQM. The correction is absent at the beginning and increases with duration of exposure. The algorithm assumes
that the first data in the SQM file was recorded when the SQM was new and that the SQM was continuously
mounted outdoors to the end of the data records. The default estimate is 0.0189 magnitudes per arc second squared
per year of exposure time.

7. Max MPSAS allowed – after the adjustments described above, data records higher than Max MPSAS allowed will be
deleted. Cloudy night skies in areas lacking light pollution will record high values, such as 23.5 or 24.0 magnitudes
per arc second squared because the clouds appear black and block the stars from view. And, these dark clouds
may not be eliminated by either the cloud algorithm or the sparse algorithm (described next). It is widely believed
that most clear and skyglow-free night skies will not exceed 22.0 magnitudes per arc second squared, which is the
default parameter value. However, graphical inspection of your data may show that pristine night skies will show
valid values of about 22.10 magnitudes per arc second squared. This cutoff ensures that unexpectedly large values
are excluded from clear sky summary data.

8. Sparse cutoff – At times, the SQM will record data under night sky conditions such as constant cloud cover, fog,
smoke or snow. It is desirable to eliminate these data records to avoid contamination of estimates of clear night sky
summary statistics.
Because the SQM may record relatively constant values under these conditions, those SQM records will not be
filtered out by the cloud algorithm, which assumes variability of data to detect cloudy conditions. The sparse
cutoff parameter governs an algorithm designed to detect and segregate those relatively constant, non-clear sky
data records. Choose a sparse parameter value of zero to prevent any data points going to the sparse bucket. An
alternative to this automated approach is to manually delete the non-clear sky data points in some other graphical
software.
After any sun, moon, Milky Way and cloud parameters are applied to filter the data, and after any data adjustments
are applied, this algorithm creates an internal 2D plot of time-of-night versus SQM readings. Most of the data will
overplot itself in a “dense” pattern, which is characteristic of the most commonly occurring clear sky conditions
at that SQM site. SQM data recorded under nearly constant, non-clear skies (overcast, foggy etc) will occupy less
dense areas of the 2D plot, either above or below the area of dense data on the plot. The goal of this algorithm is
to remove those “sparse” data points by spatial filtering in that 2D plot. Figures 7.18 and 7.19 show the impact of
this sparseness filter process.
The sparseness algorithm sets up an internal 2D plot in X and in Y. The X dimension is MinutesSince3pmStdTime,
and ranges from 0 to 1440 minutes, divided into 5-minute-wide bins. The Y dimension is MPSAS (magnitudes/arc
sec squared) and ranges from 0 to 23, divided into 0.05 mags/arc second sq tall bins.
This algorithm passes a 2D filter over the data in the 2D plot (Figure 7.20). At each occupied cell of the 2D plot, it
sums the population count in 12 nearby cells, around the central target cell. If the count is small, and less than the
sparseness parameter (for example, 25), it is considered to be a sparse point, and target cell data record is written
out to the “Sparse” csv file. If not, the target cell data record is written out to the “Dense” csv file.
As shown in Figure 7.20, the 12 nearby cells are seven cells tall with a central 3x3 area, excluding the target cell.
The blank point in the middle of the filter is the target point. The area processed is taller than is wide because
the sparse points tend to have blank areas above them in the XY scattergram. The tall pattern is designed to
successfully identify the sparse points.

This program creates three output files:

1. A csv file of the selected data records labelled “Dense” this file contains those data records which pass the sun,
moon, cloud, Milky Way, max MPSAS allowed and sparse cutoff filters - i.e. “dense” data which represents the
most commonly occurring data at an SQM site; this file has the same format at the input .csv file
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2. A csv file of the selected data records labelled “Sparse” which pass the sun, moon, cloud, milky way and max MPSAS
allowed, but which are segregated by the sparse cutoff test - these are the scattered data points which passed the
cloud removal filter, but which are probably caused by constant cloud cover, fog, snowy conditions, etc.; this file
also has the same format at the input csv file

3. A text file that lists the parameter values and summary statistics for the filtered data. After the filtering for sun,
moon, MW and clouds, and applying any corrections specified, the text file lists the mean, min and max of the
selected data points. This is a summary of the combined records of the “Dense” and “Sparse” output files.

And, after filtering out any sparse points, the text file lists the mean, min and max again. This is a summary of
the records in the “Dense” output file. If parameters are chosen well, this is a summary estimate of the brightness
of the night clear sky data recorded by the SQM.

For quality control, it is good practice to graphically display both the “Dense” and the “Sparse” csv files. Graphical
display allows you to understand the implications of your parameter choices. For example, you may want to change
the cloud cutoff value to exclude more records or the sparse cutoff value because too many, or too few, of the data
points were assigned to the sparse bucket.

Figure 7.18: Several years of data from one SQM site summarized in a 2D plot, after filtering for sun, moon, Milky Way
and clouds. Colors are proportional to the number of data points at each cell of the plot. Red represents
most frequent points, blue least frequent. The goal of the sparseness filter is to remove the data points that
plot away from the most dense data, to avoid bias of measurement of the clear night sky brightness. See
Figure 7.19
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Figure 7.19: Same data as Figure 7.18, but after application of the sparseness filter. The remaining data can provide a
good estimate of the night sky brightness at this SQM location.
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Figure 7.20: Diagram of the sparseness filter. Blue squares represent SQM measurements acquired under infrequent
overcast or foggy conditions. The goal of the sparseness algorithm is to identify them for segregation into
the “Sparse” output csv file.
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7.3.7 Help menu

Figure 7.21: Help menu

Help : Online manuals shows online links to the meter manuals. Click on the desired meter to open that PDF manual
in your browser.

Help : Online resource links to the updated online Unihedron resource files that are sent out with each meter.

Help : Cmdline Info shows the commands that can be used when starting UDM from the command line.

Help : Version Info shows the detailed version information for the UDM software.

Help : About displays a simple screen with the version identifier.

Figure 7.22: Help : About

Found devices box shows all the connected SQMs available that UDM can find from this computer.
If only one device is found, then UDM auto-selects it and gathers the version information for that selected device.

Figure 7.23: Found device (single)

If more than one device is found, then UDM does not select any of the devices. You may select the desired device by
clicking in the found devices box on the SQM that you want to know more about. Once you select the device, then the
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connection details are displayed. Clicking on the “Version” or “Reading” button will gather more information from the
meter.

Figure 7.24: Found device (multiple)

Device details shows the connection details of the selected SQM listed in the “Found devices” box.
The USB “Port” field is editable so you may enter your own port that might not be defined in the found box. See

Figure 7.25.

Figure 7.25: USB connection details

The Ethernet IP and port fields are editable so you may enter your own IP and port that might not be defined in the
found box. The default port number for the SQM-LE is 10001. See Figure 7.26.

Figure 7.26: Ethernet connection details

The RS232 fields are editable so you may enter your own port and baud rate. The baud rate for the SQM-LR is 115200.
See Figure 7.27.

Figure 7.27: RS232 connection details

7.4 Information tab
The information tab is used to show information about the version and the reading of the selected SQM.

50 Unihedron SQM-LE Operator’s Manual - 20260307



7.5 Log Continuous

Press the “Version” button for an updated list of data about the device version, and press the “Reading button” for an
updated list of data about the device reading.

Figure 7.28: Information tab

The Header button calls up the data file header entry screen, see the datalogging Header section on page 33 for more
information. This header information is used when storing logged data to the disk with the “Log one record” or “Log
continuous” functions described below.

Log one record gathers one data record from the connected SQM and stores that information to a data log file on the
disk in the “Logs directory path”. The location of the file can be identified and changed by “View : Directories”. The log
file can be accessed later from the “File : Open” menu.

7.5 Log Continuous

The “Log continuous” function allows data from the connected SQM device to be logged repetitively as shown in Figure
7.29.
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Figure 7.29: Log Continuously screen

Log Continuous Trigger options must be defined before logging, see Figure 7.30 for possibilities:

Figure 7.30: Log Continuously Trigger tab

Figure 7.31: Log Continuously Look tab
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Figure 7.32: Log Continuously Status tab

To operate the continuous logging function:

1. Select the frequency of logging from the trigger tab.
2. Select if “Moon data” is to be computed and logged.
3. Select “Freshness” to identify Fresh/Stale results. This is useful when recording brightness from a moving platform,

specifically.
4. Enter“Split (local time)” to adjust the starting time of the recorded .dat file. The default is at 0 (midnight), but

you can set that to 12 to have the night time readings centered in the .dat file and plot views.
5. Select “Single .dat file” to prevent separate daily files being created each 24 hours.
6. Select “GoTo accessory” when the meter is mounted on a GoTo tripod and direction commands come from the

GoTo tab.
7. Select “Raw frequency” when the rFx command is desired which send the linear raw light reading frequency.

(Firmaware 75 and above).
8. Select a limit to the number of records. A value of zero is default and means there is no limit. Any other value

1-1000 means that UDM will stop recording after that many records have been taken.
9. Press the “Record” button. The records are stored in a logfile whose location is shown in the “Logfile name” area.

A new logfile is automatically created at the beginning of each day (at local time 0:00).
10. Press the “Stop” button when you want to stop the recording process.
11. Log files can be accessed by the “File : Open” menu selection or by pressing the “folder” button shown in the “Log

Continuously” screen.
12. Press “Close” when done with the continuous logging feature.

Threshold to record A threshold for recording readings can be set before starting recording. Any reading greater or
equal to this threshold value will be recorded in the log file.

Figure 7.33: Log Continuously Threshold

A threshold of 0 will allow all readings to be recorded.
The threshold indicator will turn green if the threshold of the triggered reading is met (recording) and red if the

triggered reading is below the threshold (no recording).
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The threshold value is saved in the registry configuration file when it is changed. Changes can only be made while not
recording.
An override from the command line options (-LCTH,x) can be made. The override will only take effect for the current

session and will not alter the saved configuration.

Audio alerts In cases where you want to be alerted that a reading will be taken, for example, when manually pointing
the meter, the Pre-reading audio alert named prereading.wav can be enabled as shown in (Fig. 7.34) to play an audio
file two seconds before the light meter record is logged. The “Test” button plays this file for test purposes.
Also, an optional reading alert sound file named freshreading.wav can also be played exactly when the reading has

been gathered by selecting an option from the reading alert box. By selecting “Fresh only”, the sound is only played when
the meter gathers a “Fresh” reading ( Fresh readings are defined in the Light measurement section 3.1). By selectingh
“All”, the sound is played after every light meter reading has been recorded.

Figure 7.34: Log Continuously alerts

The audio files are located in the Data Directory (which can be identified from the main page View→Directories).

Alarm for darkness When the darkness is over the threshold amount, an audio file can be enabled to play (Fig. 7.35) .
The Test button plays this file for test purposes. The audio file is named alarmsound.wav and is located in the the Data
Directory (which can be identified from the main page View→Directories).

Figure 7.35: Log Continuously Alarm for darkness

Transfer reading Each reading can be sent by TCP to an external destination (remote) server.

Figure 7.36: Log Continuously Transfer reading
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To set up this feature:

1. Enter the IP address of the destination server.

2. Enter the port of the destination server.

3. Check the Enable box.

4. Start logging.

The TEST button is available to check if the reading packet can be sent to the destination server.

To send data to the Globe at Night server:

• Make an email request to globeatnight.network@gmail.com

• Provide your GPS location.

• Provide your City/State/Country.

• Provide your serial number.

• Ask them for the IP address and Port number.

• Double check with them at a later date that your readngs have been received.

An example packet which contains the reading and the serial number (Rx reading response) looks like this:
r, 00.00m,0000547954Hz,0000000000c,0000000.000s, 022.8C,00000494

Transfer file The .dat file can be sent via FTP, SCP, or SFTP to a server by making settings on the left side of the
Transfer tab (shown in Fig. 7.37)

Figure 7.37: Log Continuously Transfer tab

The following transfer protocols files is available:

• FTP (File transfer protocol).

• SCP (Secure file Copy) transfers require that the scp command exists externally from UDM. For Linux and Mac,
the scp command is scp and can be proven to exist with the which scp command. In Windows, if you do not have
access to scp, you may have to install a program called pscp and rename it to scp.
Make sure that the SSH connection from the UDM machine to the remote machine can be opened without a
password. You will have to copy the public key etc. to make a passwordless connection.

• SFTP (Secure File Transfer Protocol) assumes that the sftp command exists. This is not available for Windows
at this time.
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Files will be sent to the server using one or more of the following options:

• .dat sends the date-named .dat file which contains recorded readings.

• .csv sends the date-named .csv file which contains recorded readings in comma separated variable format.

• Plot sends the daily plot and an html file that can be used to display on a web server (details below)

Timeout (ms): tells UDM how long to wait before giving up on the transfer. When all is working well, a value of
1000ms (one second) should be sufficient.
The Results box shows some testing diagnostics.
The Local filename: is the path and file name that will be transferred to the remote server.
The Remote filename: shows the path and name of the file that should be sent to the remote server.
The Test button will initiate a transfer for testing the settings were results are shown on the screen beside and below

the Test button.
When the Plot option is selected, UDM fills in the sqm-template.html file in the data directory with reading and date

variables, then sends the resulting filled-in information as sqm.html to the server. A date-named plot file is also sent (its
name is defind as startdate.png and encoded inside sqm.html in the imagename variable described below).
The possible variables that you can use in the sqm-template.html are:

• <!-- SQM-location --> The location name taken from the associated header entry.

• <!-- SQM-coordinates --> The GPS coordinates taken from the associated header entry.

• <!-- SQM-timestamp --> The timestamp of the current reading.

• <!-- SQM-nexttimestamp --> The timestamp of the next reading.

• <!-- SQM-mpsas --> The current reading in mpsas.

• <!-- SQM-nelm --> The current reading in mpsas.

• <!-- SQM-cdm2 --> The current reading in mpsas.

• <!-- SQM-mcdm2 --> The current reading in mpsas.

• <!-- SQM-NSU --> The current reading in Natural Sky Units.

• <!-- SQM-Best --> The best reading of the plot in mpsas.

• <!-- SQM-BestTime --> The time that the best reading was recorded.

• <!-- SQM-imagename --> The filename of the plot file, will be something like 20220501.png.

Each variable must be on its own separate line in the sqm-template.html file, and the variable must start at the
beginning of the line. See the sqm-skeleton.html file for an example. If the sqm-template.html does not exist after initial
installation, then it is created from a copy of sqm-skeleton.html file located in the initial program installation directory

Annotation settings While the “Log Continuous” mode is recording data, annotations can be made to the log file records
with hotkeys. The Annotation tab allows the definition of hotkeys and their associated annotation text that will appear
at the end of an annotated record.
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Figure 7.38: Log Continuously Annotation tab

Persistent annotation The “Persistent” mode makes the annotated text persistently appear at the end of each logged
record after the first time the hotkey is pressed.
Without “Persistent” checked, annotation text is only appended to a record when the hotkey is pressed, and other

records have no annotation text.

Synchronized annotation The “Synchronized” mode postpones annotation requests until the next scheduled record so
that the annotated text is synchronized with scheduled triggered recordings.
Without “Synchronized” checked, the hotkey will immediately trigger a record log, and the associated annotation text

will be appended to that triggered record.

GPS UDM will read the data produced from an externally connected USB or serial GPS receiver like the GlobalSat
BU-353 GPS. Also the Bluetooth GPS Dual XGPS160 has been test on a Mac.

Figure 7.39: Log Continuously GPS tab

The following GPS units have been tested with the latest UDM software:

GPS Connection Settings
GlobalSat BU-353 USB 4800 baud

GlobalSat BU-353 S4 (5Hz) USB 115200 baud
Dual XGPS160 Bluetooth See GPS owners manual
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Enter the communications port name (see below) into the Port field, the baud rate into the baud field, then enable the
GPS. Once enabled, UDM continuously scans the GPS port for three NMEA words.

GPS on Windows 10 To get the Communications Port for a USB connected GPS to a Windows 10 computer:

1. Click Start → Settings → Devices → Connected-devices

2. The GPS should show up there as ”Prolific USB-to-Serial Comm Port (COMx)”. note which Comm port is listed,
one example is COM6 GlobalSat BU-353 S4 (5Hz)

3. Make sure that no other programs are accessing the GPS.

4. Start up UDM, make sure you meter is selected

5. Select Log Continuous → GPS-tab

6. Enter the Comm Port into the Port: field, in my case I just typed in COM6

7. Enter the baud rate for the GPS into the Baud: field, in my case I just typed in 115200

GPS on Mac To get the Communications Port for a USB connected GPS to a Mac computer:

1. Follow the instructions for driver installation on the CD provided with the GPS

2. Connect the GPS

3. Open a terminal window

4. Type in: ls -altr /dev/* to look for the most recently created file that looks something like cu.usbserial

5. The newly connected GPS is located at something like /dev/cu.usbserial

6. Make sure that no other programs are accessing the GPS.

7. In UDM → Log-continuous → GPS → Port:, type in that filename. An example would be: /dev/cu.usbserial

8. Enter the baud rate for the GPS into the Baud: field, in my case I just typed in 115200

GPS and SQM startup procedure Some computers reassign the communications port at power up or re-connection, so
to ensure that the UDM can recognize both the SQM and the GPS, please follow these steps:

1. Disconnect the SQM and GPS from computer before powering up.

2. Power up the computer.

3. Start up UDM.

4. Connect the SQM and ensure you get a reading.

5. Disable the GPS connectivity from the log continuous tab.

6. Connect the GPS, and under the Log Continuous GPS tab ensure you are getting GPS location data.

7. Carry on from there.

GPS status Upon successful parsing of the GPS data, UDM illuminates (with bright green) the associated indicators
(GPRMC, GPGGA, GPGSV). If too much time passes, the indicators fade to black.
The signal strength group shows the signal to noise ratio (SNR) for all visible satellites. The satellite number is displayed

below each signal strength meter.
The location, speed, time, and status information is displayed as it is received.
If the GPS is enabled before logging, then the logfile is forced to ”MOVING” platform mode, and five fields (latitude,

longitude, elevation, speed, number of satellites in view) are appended to each record.
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GoTo A GoTo pointing device accessory can be controlled by UDM for the purpose of pointing the meter to various
parts of the sky and automatically gathering a reading at each position.
The following GoTo devices are currently supported:

• SynScan V4

• iOptron 8408

The connection of the GoTo device is made to the serial port. Note; some USB to RS232 serial adapters do not act
properly with UDM. Usually an FTDI adapter should work well.
Select the machine type, port, and baud rate. Ensure that the connected device is actually available on the port you

select. In Windows, you can use the Device manager, In Mac and Linux, you can type dmesg on the command line in a
terminal window to see the latest USB device attached.
A script file containing the positions is located in the “Data Directory” which is identified by:

View→Directories→Data_Directory.
On a Mac, you can use Finder to go to “Applications”, then right click on “udm” or “udm.app” then select “Show

contents”. Then you can navigate to Contents→Resources to see the location of the *.goto file(s).
The format of the GoTo script file is a semicolon-separated file with an extension of “.goto”. Comment lines are preceded

by the pound symbol (#). The second line defines the field format (Zenith;Azimuth). The remaining lines define the
points to move to. An example is:

# Default
# Zenith;Azimuth
0;0
15;0
15;60
15;120

Control of the positioning is done from the trigger page. The “Goto accessory” and “Freshness” check boxes must be
set. Pressing the ”Record” button will start the pointing sequence.

7.5.1 Import.dat into spreadsheet
The .dat file generated by UDM can be imported into a Microsoft Excel spreadsheet for calculations and graphing purposes
as follows:

1. Start excel

2. File Open

3. Select ”All files”

4. Select your .dat file (previously recorded and saved).

5. Select ”delimited” (as opposed to the default ”fixed width”)

6. Import starting at line 33

7. Next

8. Unselect ”Tab”

9. Select ”Semicolon”, you should see bars separating the data fields now.

10. Next

11. Define each field. European users will have to select ”Advanced”, then change the ”Decimal point” to ”.” and
”Thousands separator” to ”,”

12. field 1,2 = date YMD

Note: You can also use the “.dat to Moon .csv” tool shown in Fig. 7.11 to create a comma separated variable file for
importing into a spreadsheet like Excel.
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7.6 Calibration tab
The Calibration tab is used to show and set the calibration data for the selected SQM device.

Figure 7.40: Calibration tab (initial)

Press the “Get Calibration Info” button so that the updated calibration data is brought in from the SQM on to the
Actual values boxes as show below.

Figure 7.41: Calibration tab (populated)

Use the following steps to change the calibration values:

1. Enter the new calibration data on the left side entry box (Desired values column).
2. Press the associated “Set” button.
3. The value is sent to the SQM, and then confirmed in the right side box (Actual values column).

Note that temperatures set in to the SQM use their own resolution and may not be reflected as the same value entered.
For example. 24.7°C might read back as 24.8 °C.
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The original factory calibration values were provided on a paper with the shipped unit. If you have lost this information,
please contact Unihedron to have the information emailed.

7.7 Report Interval tab
The Report Interval tab is used to show and set the report interval information for the selected SQM. Report interval
settings are used to control the SQM to send readings out at a regular rate (in seconds) and only if darker than a specified
threshold value. See section 8.9 on page 113 for more information about “Interval reporting”.

Figure 7.42: Report interval tab

Use the “R” button to temporarily set the value in to RAM for experimentation. The new value will be used instantly.
The RAM value is set to the EEPROM value on power-up.
Use the “E/R” button to set the value in to EEPROM and RAM. The new value will be used instantly and also after

power up.
Report interval is measured in seconds (i.e. 300 = 5 minutes).
Report threshold is measured in Magnitudes per square arcsecond (mpsas), a larger positive value is darker.

7.7.1 Continuous reports
The Continuous reports section enables special features related to reporting through an optionally installed I2C interface
except for the Ideal crossover function selection.

Reporting enabled: The readings are sent to the I2C adapter as they are computed.

Reporting compressed: High speed reporting is sent out in a compressed format.

Report un-averaged: Send only the unaveraged readings to the I2C device.

LED blink accessory: Enables the LED on the DL models to blink each time a reading is gathered.

Ideal crossover firmware: See Theory of operation section 3.1 for full details.
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7.8 Firmware tab
In a case where new firmware is supplied by Unihedron to correct bugs or add features, use this tab to select and load
firmware in to the SQM-LE.
All available versions of firmware are shipped with the UDM software package in case you want to revert to an earlier

firmware version for testing purposes. New firmware versions are announced on the Unihedron forum.

Figure 7.43: Firmware tab

Follow these steps to load new firmware:

1. Press the “Select Firmware” button to choose the firmware file to load into the SQM as shown in Figure 7.44:

Figure 7.44: Firmware selection

2. Select the desired firmware file then press “Open”.
3. The “Load firmware” button will be enabled and you can press it now to start loading the firmware into the SQM-LE.

The status bar will indicate successful completion when the firmware has been completely loaded.

When using a Mac or Linux, the firmware can be loaded/restored using the “USB comm check” method when the
associated buttons appear. The steps are shown as follows:
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1. Start UDM
2. Have the meter connected
3. Go to the firmware tab
4. Select the appropriate firmware like SQM-LU-DL-4-6.67.hex
5. Press the ”START UNPLUG METHOD button
6. Follow the instructions shown on the right side of the button.

7.8.1 XPort defaults
The SQM-LE comes shipped with the Ethernet XPort module default setting changed differently for use in the SQM-LE
meter. Altering these these settings with the web browser or Lantronix Device Installer may render the meter temporarily
unusable.
Press the “XPort defaults” button on the “Firmware tab” page to reload the SQM-LE special settings.

Unihedron SQM-LE Operator’s Manual - 20260307 63



7 Unihedron Device Manager

7.9 Configuration tab

The “Configuration tab” shows the factory-set calibration values.
Calibration is performed at the Unihedron factory. A new calibration using a calibrated light source and darkroom can

be performed by following the instructions on the right side of the screen. The calibration report can be logged to a data
file and also printed out from this screen.

Figure 7.45: Configuration tab

Warning confirmations as shown in Figure 7.55 and Figure 7.56 are shown when trying to calibrate the unit yourself:

Figure 7.46: Light calibration confirmation

Figure 7.47: Dark calibration confirmation

7.9.1 Sensor arrangement

For documentation purposes, the SQM-LE can store information on the sensor arrangement (starting at firmware feature
35 and above). The type of Lensholder, Lens, and Filter can be defined.
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Figure 7.48: Sensor arrangement

7.9.2 Lock switch settings
The SQM-LE with firmware feature 46 and above has optional control of how the lock switch operates. The Lock switch
always protects firmware upgrading, but it can optionally protect Calibration settings, Report Interval settings, and
Configuration settings.

Figure 7.49: Lock switch settings

When the ”These options” setting is checked, then none of the above settings can be changed while the unit is locked.

7.10 Simulation tab
The “Simulation” tab is enabled from the View menu.
The “Simulation” tab allows the simulation of raw light sensor values for experimentation purposes. The “Start” button

initiates feeding the range of values to the internal formulas of the SQM-LE and results are displayed on this tab. Raw
temperature conversions are detail in Eq: 8.1 and 8.2. The simulation will stop once all the steps are complete or when
the “Stop” button is pressed.

Figure 7.50: Fig:Simulation tab

When using the Simulation mode of the SQM-LE, make sure that nothing else interrupts the sequence of readings such
as external programs reading from the SQM-LE, or settings of Interval reporting inside the SQM-LE.

7.10.1 Simulation from file
The “From file” button sends csv data from simin.csv (in the log file directory) to the SQM-LE in simulation mode and
puts the output into simout.csv. The format of the csv is shown in Table 7.7:
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Table 7.5: simin.csv field description

Position Example value Description

1 3000 Period in counts.
2 30 Frequency in Hz.
3 20.3 Temperature in °C.

Listing 7.2: simin.csv example
0,568380,24.8
72970,6,13.2

The resultant output records will be shown on the screen and saved in simout.csv (in the log file directory) in the
form of simulated result shown in section 8.10 as in the example shown in Listing 7.3:

Listing 7.3: simout.csv example
# Simulation from file.
# UDM version: 1.0.0.43
# Unit information cx: i,00000004,00000003,00000032,00000704
# Calibration cx: c,00000019.80m,0000107.511s, 028.3C,00000008.71m, 029.3C
S,0000000000c,0000568380f,0000000232t,r, 00.00m,0000568380Hz,0000000000c,0000000.000s, 024.8C
S,0000072970c,0000000006f,0000000196t,r, 17.79m,0000000006Hz,0000072970c,0000000.158s, 013.2C

7.10.2 Test response
The Test resp. button activates code to reset the SQM-LE then send multiple r1x commands. Watch the log
for ,F to see when the SQM-LE starts reporting fresh readings.
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7.11 Accessory options
Some meters can be equipped/retro-fitted with optional accessories if they include firmware feature version ≥40.
See section 8.7 for details on the accessory commands.
The accessories tab (shown in 7.59) is available when selecting a device that has the appropriate firmware:

Figure 7.51: Accessories tab

7.11.1 Humidity accessory
There are currently two types of I2C humidity sensors that have been tested; HIH8120, and HYT939. The selection can
be made with the drop down combo-box on this tab.
Enabling this sensor allows the SQM-LE to poll the sensor once per second to gather a reading which can be requested

later with the A1x command.
The refresh button requests the most recent value that the SQM-LE has collected.
The Status field shows the status of the humidity sensor which is updated after the refresh button is pressed. The

status is ‘N/C’ when the sensor is not connected.

7.11.2 Display accessory
A 4-digit 7-segment I2C display can be attached to the SQM-LE. Currently only the Sparkfun COM-11441 has ben tested.
This display shows the brightness reading in mpsas.
The brightness of the display can be fixed at a level between 0-7 (dimmest to brightest), or can be automatically dimmed

in bright conditions (depending on the mpsas reading).
The display can be either updated periodically (1Hz) or whenever a reading request is made.

7.11.3 LED accessory
The LED indicator accessory is mainly used for troubleshooting to identify either when readings are created or requested.
The The LED blinks for 1/60th of a second.
The LED can blink either when the SQM-LE creates a reading, of when a reading is requested (using the rx command).

7.11.4 Relay accessory
The Relay accessory is mainly used for dew heater control. A 3.3V activated solid state relay can be connected directly
to pin 23 of the micro-controller (25mA drive maximum).
When in Manual mode, the relay can be turned on or off.
When in Automatic mode, the relay is turned on when the mpsas reading is above the threshold and off when the

mpsas reading is below the threshold.
Pressing the On/Off buttons while the relay is in automatic mode will switch it to manual mode.
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7.12 Command line parameters
UDM can be started from the command line. Other stored parameters (like timezone) will be recalled automatically.
Here is the summary of options:

Table 7.6: Log continuous command line parameters

Parameter Description

-LCMS,x Every x seconds
-LCMM,x Every x minutes
-LCM,1 Every 1 minute on the minute
-LCM,5 Every 5 minutes on the 1/12th hour
-LCM,10 Every 10 minutes on the 1/6th hour
-LCM,15 Every 15 minutes on the 1/4 hour
-LCM,30 Every 30 minutes on the 1/2 hour
-LCM,60 Every hour on the hour
-LCR Start recording right away
-LCMIN Minimize Application after Log continuous window starts up
-LCTH,x Threshold setting. Readings equal to or greater than x (in mpsas)

get recorded. If x=0 then all readings are get recorded.
-LCGRS Run GoTo script then shut down when done

Table 7.7: Select device command line parameters

Parameter Description

-SEI,x Select Ethernet device where x = IP address
-SEM,x Select Ethernet device where x = MAC address
-SUC,x Select USB device

where x = communication port-name i.e. /tty/USB0
-SUI,x[,y...] Select USB device where x = ID number ex FTD12345, or multiple

IDs for LogContinuous with the first one being the priority set like:
-SUI,FTD12345,FTD33333,FTD55555

Table 7.8: Select features command line parameters

Parameter Description

-N Do not search for devices at startup. This cuts down startup time,
the user must press the Find button to find devices.

-P Display plotter window.
-TCA Start up Concatenate/Analyze tool
-TCM Start up Cloud removal / Milky way position tool

Table continued on next page ...
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Table 7.8 – continued from previous page
Parameter Description

-TCMR Start up Cloud removal / Milky way position tool, and recall previous
filename

7.12.1 Internal startup options
UDM also has the ability to store the startup options internally so that no extra command line parameters are required.
You can access this setting from File -> Startup options menu.

7.12.2 Windows autostartup
To get Windows to open up UDM at startup:

• Select the Start button and scroll to find the Unihedron Device Manager app that you want to run at startup.

• Right-click the app, select More, and then select Open file location. This opens the location where the shortcut to
the app is saved. If there isn’t an option for Open file location, it means the app can’t run at startup.

• With the file location open, press the Windows logo key + R, type shell:startup, then select OK. This opens the
Startup folder.

• Copy and paste the shortcut to the app from the file location to the Startup folder.

To get UDM to start the log continuous feature when starting up:

• Make sure that you already tested the Log Continuous feature so that it works correctly.

• Press the Windows logo key + R, type shell:startup, then select OK.

• Right click on the UDM icon that should have been there from the above steps

• Show more options, then press Properties

• Edit the TARGET to put double quote marks around the executable, but do not change the text, and add a space
and then -LCR to end. It will look something like this:
"C:\Users\User\AppData\Local\Unihedron\udm.exe" -LCR

Note: If you have more than one device that UDM finds, then it will be important to identify that defice on startup,
for example like this example to find the USB device with USB ID 12345678 and starts logging to disk:
"C:\Users\User\AppData\Local\Unihedron\udm.exe" -SUI,12345678 -LCR

Note: You can leave out the above optional parameters from the command line if you include those in the internal
startup options in the UDM File -> Startup options menu.

7.12.3 Windows scheduled startup
In Windows, you can use the Task Scheduler to start and stop recording.
First make sure that UDM can read your meter and can log data using the Log Continuous feature. Also, use UDM to

determine the MAC address of the meter (on the main page). Then, close UDM.
Enter the start/stop times into the Windows Task Scheduler. Start the task scheduler as follows:

1. Click the Windows ”Start” button

2. Start typing Schedule Tasks

3. Select the Schedule Tasks or Task Scheduler program.

Unihedron SQM-LE Operator’s Manual - 20260307 69



7 Unihedron Device Manager

Then:

1. Press ”Create basic task” on the right side in the Actions window.

2. Name: Start UDM

3. Next

4. Daily

5. Enter the desired start time

6. Select Start a program

7. Click on browse to find the program which is usually located at "C:\Users\User\AppData\Local\Programs\Unihedron\udm.exe"

8. For SQM-LE, Enter additional parameter: -SEM,x -LCM,y -LCR
where x is the MAC address of the SQM-LE to be monitored, for example: 00204AAF20A2
where y is the number of minutes between recordings, for example: 5
For SQM-LU, Enter additional parameter: -SUC,x -LCM,y -LCR
where x is the MAC address of the SQM-LU to be monitored, for example: COM1
where y is the number of minutes between recordings, for example: 5
More command line definitions found in UDM->Help->Command line information

9. Next, Finish

Tasks may not show up in the Task Scheduler library immediately, you may have to close the Task scheduler and re
start it.
Then, make another task to stop UDM at a specific time as follows:

1. Press ”Create basic task” on the right side in the Actions window.

2. Name: Stop UDM

3. Next

4. Daily

5. Enter the desired stop time

6. Select Start a program

7. Type the following into the program area: taskkill

8. Enter additional parameters: /IM udm.exe /F

9. Next, Finish

The logged files are stored in your log directory, usually located at: "C:\ProgramData\Unihedron\logs"
The above was tested with Windows 10 and UDM ver.105.

7.12.4 Mac autostartup
You can have UDM start up when you login to your Mac. Enter your UDM startup parameters in the UDM File ->
Startup options menu. Then add UDM to the Mac Login items as follows:

• Go to System Preferences > Users & Groups from the main Mac menu.

• Select your user account in the list on the left

• Click Login Items.

• Click the Add button.

• Select UDM from the Applications folder.
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8 Commands and responses
The SQM-LE accepts a sequence of characters as a command, then executes those commands and usually provides a
response of a sequence of characters. The following details are useful when programming your own interface to send data
to and receive data from the SQM-LE.

8.1 Commands
Commands consist of a string of characters. The first character is the command type. The following is a list of the
“Standard” commands:
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Table 8.1: Summary of standard commands

Command Description

rx r1x Rx R1x Reading request (averaged).
ux u1x Ux U1x Unaveraged reading requests.
rfx rFx Linear, Inline linear reading requests.
cx Calibration information request.
ix Unit information request (note lower case “i”).
zcalAx Arm Light Calibration command.
zcalBx Arm Dark Calibration command.
zcalDx Disarm Calibration command. Also reports the lock switch status.
zcal5 Manually Set Light Calibration Offset.
zcal6 Manually Set Light Calibration Temperature.
zcal7 Manually Set Dark Calibration Time Period.
zcal8 Manually Set Dark Calibration Temperature.
0x19 Reset micro-controller. Hexadecimal value 19. See the “Firmware Upgrade” chapter

on page 120 for more details.
: Intel Hex firmware upgrade initiation. See the “Firmware Upgrade” chapter on

page 120 for more details.
P…x Set period (in seconds) for interval reporting to EEPROM and RAM for booting

and immediate use. Firmware feature=13.
p…x Set period (in seconds) for interval reporting to RAM for immediate use. Firmware

feature=13.
T…x Set threshold (in mag

arcsec2 ) for interval reporting only to EEPROM and RAM for
booting and immediate use. Firmware feature≥13.

t…x Set threshold (in mag
arcsec2 ) for interval reporting only to RAM for immediate use.

Firmware feature≥13.
Ix Request interval settings (note upper case “I”). Firmware feature≥13.
sx Request reading of internal variables.
S…x Simulate internal calculations.

8.2 Response details
8.2.1 Reading request
The “Reading” request “rx” or “Rx” commands the SQM-LE to provide the current darkness value as well as all variables
used to generate that result.
Readings produced by this request are averaged internally by using the last 8 readings and shifting those values through

an 8 cell buffer then summing and dividing by 8. Use the “ux” command to get the un-averaged and most recent value.
Averaging is only performed on period-mode readings (when the light sensor frequency is below 128Hz). Frequency mode
readings (above 128Hz) are automatically averaged because the reading is taken from a one second sampling of pulses.
The format of the rx response is shown in table 8.4:
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Table 8.2: rx Reading request response

Column Example value Description

0 r Indicates that a reading is being returned.
2-8 ␣06.70m Reading in mag

arcsec2 .
Leading space for positive value.
Leading negative sign (-) for negative value.
A reading of 0.00m means that the light at the sensor has reached
the upper brightness limit of the unit.

10-21 0000022921Hz Frequency of sensor in Hz.
23-33 0000000020c Period of sensor in counts. Counts occur at a rate of 460.8 kHz

(14.7456MHz/32).
35-46 0000000.000s Period of sensor in seconds with millisecond resolution. Determined

by dividing the above counts value by 460800.
48-54 ␣039.4C Temperature measured at light sensor in degrees C. The value is

averaged and presented every 4.3 seconds.
Leading space for positive value.
Leading negative sign (-) for negative value.

55-56 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
r, 06.70m,0000022921Hz,0000000020c,0000000.000s, 039.4C␍␊

0123456789 123456789 123456789 123456789 123456789 123456

Future versions of this reading string will only modify reported values beyond position 54. Characters 0 to 54 may be
considered stable.
A special case “Rx” command returns the serial number in the same format as the interval report does. See page 113

“Setting Interval reporting parameters” for report details.
To include the “Freshness” status, use the “r1x” command. The response is shown in table 8.5

Table 8.3: r1x Reading request response

Column Example value Description

0 r Indicates that a reading is being returned.
2-8 ␣06.70m Averaged reading in mag

arcsec2 .
Leading space for positive value.
Leading negative sign (-) for negative value.
A reading of 0.00m means that the light at the sensor has reached
the upper brightness limit of the unit.

10-21 0000022921Hz Frequency of sensor in Hz.
23-33 0000000020c Period of sensor in counts. Counts occur at a rate of 460.8 kHz

(14.7456MHz/32).
35-46 0000000.000s Period of sensor in seconds with millisecond resolution. Determined

by dividing the above counts value by 460800.
Table continued on next page ...
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Table 8.3 – continued from previous page
Column Example value Description

48-54 ␣039.4C Temperature measured at light sensor in degrees C. The value is
averaged and presented every 4.3 seconds.
Leading space for positive value.
Leading negative sign (-) for negative value.

56-72 ␣06.53m Unaveraged reading in mag
arcsec2 .

Leading space for positive value.
Leading negative sign (-) for negative value.
A reading of 0.00m means that the light at the sensor has reached
the upper brightness limit of the unit.

74 F Freshness state, either:
F: fresh FREQUENCY mode reading.
P: fresh PERIOD mode reading.
S: STALE reading indicates that this reading has not changed since
the last reading because there was not enough light gathered to pro-
duce a new reading.

75-76 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
r, 06.70m,0000022921Hz,0000000020c,0000000.000s, 039.4C, 06.53m,F␍␊

0123456789 123456789 123456789 123456789 123456789 123456789 123456

The r1x request response is the same as rx, with the freshness status of Frequency/Period/Stale (,F ,P ,S)) ap-
pended
The Rx request response is the same as rx, with the serial number appended.
The R1x request response is the same as rx, with freshness status of Frequency/Period/Stale (,F ,P ,S), and the

serial number appended.

8.2.2 Unaveraged reading request
The “unaveraged reading” request ux commands the meter to provide the current darkness value as well as all variables
used to generate that result. This readings is not averaged out like the rx command.
The format of the ux response is shown in table 8.6:

Table 8.4: Unaveraged reading request response

Column Example value Description

0 u Indicates that a reading is being returned.
2-8 ␣06.70m Averaged Reading in mag

arcsec2 .
Leading space for positive value.
Leading negative sign (-) for negative value.
A reading of 0.00m means that the light at the sensor has reached
the upper brightness limit of the unit.

10-21 0000022921Hz Frequency of sensor in Hz.
23-33 0000000020c Unaveraged Period of sensor in counts. Counts occur at a rate of

460.8 kHz (14.7456MHz/32).
Table continued on next page ...
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Table 8.4 – continued from previous page
Column Example value Description

35-46 0000000.000s Unaveraged period of sensor in seconds with millisecond resolution.
Determined by dividing the above counts value by 460800.

48-54 ␣039.4C Unaveraged temperature measured at light sensor in degrees C. The
value is presented every 4.3 seconds.
Leading space for positive value.
Leading negative sign (-) for negative value.

55-56 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
u, 06.70m,0000022921Hz,0000000020c,0000000.000s, 039.4C␍␊

0123456789 123456789 123456789 123456789 123456789 123456

The u1x request response is the same as ux, with the unaveraged reading, and the freshness status of Frequency/Pe-
riod/Stale (,F ,P ,S) appended.
The Ux request response is the same as ux, validity/invalidity (,V ,I) appended.
The U1x request response is the same as ux, with the unaveraged reading, and the freshness status of Frequency/Pe-

riod/Stale (,F ,P ,S) appended.

8.2.3 Linear reading request
The “linear reading” request “rfx” commands the meter to provide the current brightness value proportional to the light
flux or frequency output from the light sensor. This value is compensated for only by the dark current frequency.
fout = flight − fdark

To allow for long period measurements, the output integer value is scaled up by a factor of 45,000.
nout = fout × 45000

The format of the response is shown in table 8.7:

Table 8.5: Linear reading request response

Column Example value Description

0-1 f, Indicates that a frequency reading is being returned.
2-11 0001287103 Frequency reading.

A reading of 0000045000 would indicate a sensor frequency of 1Hz,
but the meter limits to 25kHz for later scaling of snow factor, so the
maximum value would be 1125045000 (25kHz × 45000).

A reading of 0000000000 would indicate total darkness, but the
meter limits time readings to 85 seconds maximum, so the darkest
value would be 0000000529 ( 1

85s
× 45000).

12-13 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
f,0001287103␍␊

0123456789 123
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8.2.4 Inline linear reading request
The “inline linear reading” request “rFx” (note: capital F) commands the meter to include the current brightness value
proportional to the light flux or frequency output from the light sensor. This value is compensated for only by the dark
current frequency.
fout = flight − fdark

To allow for long period measurements, the output integer value is scaled up by a factor of 45,000.
nout = fout × 45000

The format of the response is similar to the “rx” response and is shown in table 8.8:

Table 8.6: Inline linear reading request response

Column Example value Description

0 r Indicates that a reading is being returned.
2-8 ␣06.70m Reading in mag

arcsec2 .
Leading space for positive value.
Leading negative sign (-) for negative value.
A reading of 0.00m means that the light at the sensor has reached
the upper brightness limit of the unit.

10-21 0000022921Hz Frequency of sensor in Hz.
23-33 0000000020c Period of sensor in counts. Counts occur at a rate of 460.8 kHz

(14.7456MHz/32).
35-46 0000000.000s Period of sensor in seconds with millisecond resolution. Determined

by dividing the above counts value by 460800.
48-54 ␣039.4C Temperature measured at light sensor in degrees C. The value is

averaged and presented every 4.3 seconds.
Leading space for positive value.
Leading negative sign (-) for negative value.

56-65 0001287103 Frequency reading.

A reading of 0000045000 would indicate a sensor frequency of 1Hz,
but the meter limits to 25kHz for later scaling of snow factor, so the
maximum value would be 1125045000 (25kHz × 45000).

A reading of 0000000000 would indicate total darkness, but the meter
limits time readings to 85 seconds maximum, so the darkest value
would be 0000000529 ( 1

85s
× 45000).

66-67 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
r, 06.70m,0000022921Hz,0000000020c,0000000.000s, 039.4C,0001287103␍␊

0123456789 123456789 123456789 123456789 123456789 123456789 1234567

8.2.5 Unit information
Unit information command “ix” provides details about the software in the micro-controller.
The format of the response is:
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Table 8.7: Unit information request response

Column Example value Description

0 i Indicates that the unit information response is being returned.
2-9 00000002 Protocol number (8 digits). This will always be the first 8 char-

acters (after the “i,” response). This value indicates the revision
number of the data protocol to/from the SQM-LE. The protocol ver-
sion is independent of the feature version.

11-18 00000003 Model number (8 digits). The model value identifies the specific
hardware model that the firmware is tailored for.

20-27 00000001 Feature number (8 digits). The feature value identifies software
features. This number is independent of the data protocol.

29-36 00000413 Serial number (8 digits). Each unit has its own unique serial num-
ber.

37-38 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
i,00000002,00000003,00000001,00000413␍␊

0123456789 123456789 123456789 12345678

8.3 Calibration commands

8.3.1 Calibration information request
The calibration information request “cx” returns all data about the specific light sensor in the unit required to calculate
a reading.
The format of the response is shown in table 8.10:

Table 8.8: Calibration information request response

Column Example value Description

0 c Indicates that the calibration information is being returned.
2-13 00000017.60m Light calibration offset in mag

arcsec2 .
15-26 0000000.000s Dark calibration time period in seconds with millisecond resolution.
28-34 ␣039.4C Temperature in degrees C measured during light calibration.

Leading space for positive value.
Leading negative sign (-) for negative value.

36-47 00000008.71m Offset of light sensor in mag
arcsec2 based on manufacturing reference.

The factory calibration light source is equivalent to 8.71 mag
arcsec2 , and

when the “Light calibration” button is pressed in UDM, the meter
creates the light calibration offset value (17.60 in this case) so that
the meter reads 8.71 also.

49-55 ␣039.4C Temperature in degrees C measured during dark calibration.
Leading space for positive value.
Leading negative sign (-) for negative value.

56-57 ␍␊ Carriage return (0x0d), Line feed (0x0a).
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An example of the response is:
c,00000017.60m,0000000.000s, 039.4C,00000008.71m, 039.4C␍␊

0123456789 123456789 123456789 123456789 123456789 1234567

8.3.2 Light calibration command
Calibration of the SQM-LE is done at the factory in a controlled light and temperature environment.
Executing the Light calibration command “zcalAx” arms the light calibration mode.
Flipping the switch on the back of the SQM-LE to “unlock” triggers the light calibration and modifies the calibration

values in the unit.
A calibrated light source of approximately 13.5fc is supplied to the sensor.
The format of the response is shown in table 8.11:

Table 8.9: Light calibration response

Column Example value Description

0 z Indicates that a “Calibration” response is being returned.
1 A Indicates Light Calibration mode.
2 a Indicates that the calibration is armed.
3 L L = Locked; Wait for unlock before calibrating after Arm command,

firmware upgrades are disabled.
U = Unlocked; Calibrate immediately after Arm command, Enable
firmware upgrade.

4-5 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
zAaL␍␊

012345

8.3.3 Dark calibration command
Dark Calibration is done at the factory along with Light calibration and calibration temperature recording.
Executing the dark calibration command “zcalBx” arms the dark calibration mode.
Flipping the switch on the back of the SQM-LE to “unlock” triggers the dark calibration and modifies the calibration

values in the unit.
Dark calibration is performed in a completely dark environment. Check a reading to ensure that the period is correct

after entering the dark environment, it could take a few minutes to collect an accurate dark period. A dark period of only
a few seconds is too small.
The format of the response is shown in table 8.12:

Table 8.10: Dark calibration response

Column Example value Description

0 z Calibration response is being returned.
1 B Dark Calibration.
2 a Armed.

Table continued on next page ...
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Table 8.10 – continued from previous page
Column Example value Description

3 L L = Locked; Wait for unlock before calibrating after Arm command,
firmware upgrades are disabled.
U = Unlocked; Calibrate immediately after Arm command, Enable
firmware upgrade.

4-5 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
zBaL␍␊

012345

8.3.4 Disarm calibration command
The Disarm calibration command “zcalDx” disarms calibration modes from being triggered by the unlock mode.
The format of the response is shown in table 8.13:

Table 8.11: Disarm calibration response

Column Example value Description

0 z Calibration response is being returned.
1 x Indicates “All” calibration modes.
2 d Disarmed.
3 L L = Locked; Wait for unlock before calibrating after Arm command,

firmware upgrades are disabled.
U = Unlocked; Calibrate immediately after Arm command, Enable
firmware upgrade.

4-5 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
zxdL␍␊

012345

8.3.5 Manually set light calibration offset
Calibration is done at the factory, however, in the case where calibration values must be restored or set to something else,
this command allows a new calibration value to be placed into the meter.
Executing the command “zcal5########.##x” manually sets the light calibration offset to the value specified in

“########.##”. The units are magnitudes
arcsecond2 .

The format of the response is shown in table: 8.14:

Table 8.12: Response for manual setting of light calibration offset

Column Example value Description

0 z Calibration response is being returned.
2 5 Manual Set Light Calibration Offset

Table continued on next page ...
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Table 8.12 – continued from previous page
Column Example value Description

4-15 00000017.60m Value that was set into EEPROM
16-17 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
z,5,00000017.60m␍␊

0123456789 1234567

8.3.6 Manually set light calibration temperature
Calibration is done at the factory, however, in the case where calibration values must be restored or set to something else,
this command allows a new calibration value to be placed into the meter.
The “Light calibration temperature” is the temperature of the meter when the meter was calibrated for its “Light

calibration offset”.
Executing the command “zcal6########.##x” manually sets the light calibration temperature to the value specified

in “########.##”. The units are ºC.
Note: The meter records the temperature in a raw value with different resolution, so the reply back may not be exactly

the same as the value sent.
The format of the response is shown in table: 8.15:

Table 8.13: Response for manually setting of light calibration temperature

Column Example value Description

0 z Calibration response is being returned.
2 6 Manual Set Light Calibration Offset
4-9 019.0C Value that was set into EEPROM
10-11 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
z,6,019.0C␍␊

0123456789 1

8.3.7 Manually set dark calibration time period
Calibration is done at the factory, however, in the case where calibration values must be restored or set to something else,
this command allows a new calibration value to be placed into the meter.
The “Dark calibration time period” is the amount of time that has elapsed for the light sensor to make one cycle while

in complete darkness. The meter sets a time limit of 300 seconds on this value.
Executing the command “zcal7#######.###x” manually sets the light calibration offset to the value specified in

“#######.###”. The units are in seconds.
The format of the response is shown in table: 8.16:

Table 8.14: Response of manually setting dark calibration time period

Column Example value Description

0 z Calibration response is being returned.
Table continued on next page ...

80 Unihedron SQM-LE Operator’s Manual - 20260307



8.3 Calibration commands

Table 8.14 – continued from previous page
Column Example value Description

2 7 Manual Set Dark Calibration time period.
4-15 0000300.000s Value that was set into EEPROM
16-17 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
z,7,00000300.00s␍␊

0123456789 1234567

8.3.8 Manually set dark calibration temperature
Calibration is done at the factory, however, in the case where calibration values must be restored or set to something else,
this command allows a new calibration value to be placed into the meter.
The “Dark calibration temperature” is the temperature of the meter when the meter was calibrated for its “Dark

calibration time period”.
Executing the command “zcal8########.##x” manually sets the light calibration offset to the value specified in

“########.##”. The units are ºC.
Note: The meter records the temperature in a raw value with different resolution, so the reply back may not be exactly

the same as the value sent.
The format of the response is shown in table: 8.17:

Table 8.15: Response for manually setting of dark calibration temperature

Column Example value Description

0 z Calibration response is being returned.
2 8 Manual Set Dark Calibration temperature.
4-9 019.0C Value that was set into EEPROM
10-11 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
z,8,019.0C␍␊

0123456789 1
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8.4 Lock settings
Firmware feature ≥ 46 allows fine control of how the lock switch operates.
It is recommended that all changes be made with the lock switch in the unlocked position otherwise the ”these settings”

set to true will render other settings unchangeable.
The command Kx will return the status of the Lock settings (see response below).

Table 8.16: Lock setting command summary

Command Description

Kx Report the Lock setting status.

Kmx

Change the Lock setting (where m=C,c,R,r,G,g,T,t) as follows:
C = Calibration changes respect the lock setting.
c = Calibration changes ignore the lock setting.
R = Report Interval changes respect the lock setting.
r = Report Interval ignore the lock setting.
G = Configuration changes respect the lock setting.
g = Configuration changes ignore the lock setting.
T = These setting changes respect the lock setting.
t = These setting changes ignore the lock setting.

Table 8.17: Lock setting response summary

Position Example value Description

0 K, Confirmation of Lock setting command.
1 m C = Calibration changes respect the lock setting.

c = Calibration changes ignore the lock setting.
2 m R = Report Interval changes respect the lock setting.

r = Report Interval ignore the lock setting.
3 m G = Configuration changes respect the lock setting.

g = Configuration changes ignore the lock setting.
4 m T = These setting changes respect the lock setting.

t = These setting changes ignore the lock setting.

An example response to “Kx” is:
K,crGT

8.4.1 Checking lock status
Use the zcalDx command to determine if the lock switch is in Locked or Unlocked position.
The response contains an L for locked, or U for unlocked. Other text may be present, check the zcal command for

details.

8.5 Snow LED accessory
An LED used for determining snow cover on the meter can be attached to an internal pin of the SQM-LE . This LED
shines green light out of the meter and the light sensor will see a reflection if snow is covering the meter (housing cap).
The light meter reading will be unchanged with no snow present, and about 1.6 mag

arcsec2 brighter with snow cover present.
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Table 8.18: Snow LED accessory command summary

Command Description

A50x Turn off the Snow LED accessory.
A51x Turn on the Snow LED accessory.
A5ex Enable Snow LED logging (while on battery power).
A5dx Disable Snow LED logging (while on battery power).
A5x LED accessory status.

Table 8.19: Snow LED accessory response summary

Position Example value Description

0-2 A5, Confirmation Snow LED accessory command.
3 n Where n = 0 indicates the Snow LED is Off.

1 indicates the Snow LED is On.
4 m Where m 0 indicates the Snow LED is disabled.

1 indicates the Snow LED is enabled.
5-6 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example response to “A5x” is:
A5,01␍␊

0123456
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8.6 Accessories commands
Some I2C accessory devices can be connected to the SQM-LE when using firmware feature version 44 and above. These
devices are connected by way of retrofitted wiring inside the unit or a future back panel connector.
All of the SQM-LE accessory commands begin with “A” (upper case).

8.6.1 Humidity / Temperture sensor
Two I2C humidity/temperature sensors models can be connected to the SQM-LE. All commands (seen in table 8.42) to
this accessory result in a response (seen in table 8.43).

Table 8.20: Humidity/temperature command summary

Command Description

A1Ex Enable the humidity temperature accessory.
A1Dx Disable the humidity temperature accessory.

A1Mmx
Set the model number (where m=0-7) of the the humidity temperature accessory:
0=HIH8120
1=HYT939 (Sold by ControlEverything and others)

A1x Report on the humidity temperature status.

Table 8.21: Humidity/temperature response summary

Position Example value Description

0 A,1, Confirmation of humidity/temperature accessory command.
1 1, Accessory 1 (Humidity/temperature sensor).
2 e, E for enabled.

D for disabled.
3 m, Model number (where m=0-7):

0=HIH8120
1=HYT939 (Sold by ControlEverything and others)

4 s Status (0-3).
0 = Normal Operation, Valid Data that has not been fetched since
the last measurement cycle.
1 = Stale Data: Data that has already been fetched since the last
measurement cycle, or data fetched before the first measurement has
been completed.
2 = Sensor in Command Mode.
3 = Not used.

5 nnnnn Humidity(%RH) = nnnnn
214−2 × 100%. 16383 when no connection.

6 nnnnn Temperature(°C) = nnnnn
214−2 × 165− 40. 16383 when no connection.

␍␊ Carriage return (0x0d), Line feed (0x0a).

An example response to “A1x” is:
A,1,E,1,0,07788,06202␍␊
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8.6.2 Display accessory
An I2C 4-digit 7-segment display made by Sparkfun (model COM-11441) can be connected. All commands (seen in table
8.44) to this accessory result in a response (seen in table 8.45).
Readings that are too bright for the SQM-LE will show up as u u uu . Readings that are too dark for the meter will

show up as t t tt .

Table 8.22: Display accessory command summary

Command Description

A2Ex Enable the display accessory.
A2Dx Disable the display accessory.
A2Fx Fixed mode of brightness.

A2Ax

Auto mode of brightness. Lowers brightness on dark nights.
Display at lowest brightness (30%) when greater than 19.00mpsas.
Display at medium brightness (50%) between 17.00 to 19.00mpsas.
Display at full brightness (100%) when less than 17.00mpsas.

A2Mnx Set the model of display (where n = 0-3).
A2Vnx Set the fixed mode brightness (where n = 0-7).
A2Px Set the updating mode to periodically updating at 1Hz.
A2Rx Set the updating mode to updating when reading request is made.
A2x Report on the display status.

Table 8.23: Display accessory response summary

Position Example value Description

0 A, Confirmation of display accessory command.
1 2, Accessory 2 (Display).
2 e, E for enabled.

D for disabled.
3 m, Model number (where m = 0-3).
4 m, F=Fixed mode.

A=Auto mode. See table 8.44 for description.
5 n, Fixed brightness level (where n = 0-7).
6 m P = periodically updating at 1Hz

R = updating when reading request is made.
␍␊ Carriage return (0x0d), Line feed (0x0a).

An example response to “A2x” is:
A,2,E,0,F,2,R␍␊
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8.6.3 LED accessory
For purposes of troubleshooting, an LED with series resistor can be connected to an internal pin of the SQM-LE. All
commands (seen in table 8.46) to this accessory result in a response (seen in table 8.47).
Using the LED to indicate when a reading is being requested is an ideal method to determine if the controlling software

is actually accessing the SQM-LE.

Table 8.24: LED accessory command summary

Command Description

A3Ex Enable the LED accessory.
A3Dx Disable the LED accessory.

A30x

Mode=Blink at reading creation.
In bright sky conditions, readings are created once per second in frequency-mode. In darker
sky conditions, the meter goes into perdiod-mode starting at 679Hz and lower, and LED
will blink at a variable rate.

A31x Mode=Blink at reading request.
A3x LED accessory status.

Table 8.25: LED accessory response summary

Position Example value Description

0 A, Confirmation of display accessory command.
1 3, Accessory 3 (LED).
2 e, E for enabled.

D for disabled.
3 m, Model number (where m = 0-7).

0 = LED connceted to pin-13 through 1k resistor to ground.
4 m, Mode of operation (where m = 0-1):

0 = Blink at reading creation.
1 = Blink at reading request.

␍␊ Carriage return (0x0d), Line feed (0x0a).

An example response to “A2x” is:
A,3,E,0,1␍␊
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8.6.4 Relay accessory
A Solid State Relay (SSR) accessory may be connected to the SQM-LE for generic use or for purposes of implementing a
dew-heater control. All commands (seen in table 8.48) to this accessory result in a response (seen in table 8.49).

Table 8.26: Relay accessory command summary

Command Description

A4x Get status of the relay accessory.
A40x Deactivate the relay accessory. Also places the accessory into manual mode.
A41x Activate the relay accessory. Also places the accessory into manual mode.

A4Mnx

Set the mode of operation:
0=Light threshold activated.
1=Dewpoint activation.
2=Heat activated.
3-6=future use.
7=Manual mode where only the A40x and A41x commands affect the relay activation.

A4Tnnx

Set the darkness threshold for relay activation. Where nn is the the darkness threshold.
The relay will be activated above this threshold.
Monitoring is perfomed once per second.

Table 8.27: Relay accessory response summary

Position Example value Description

0 A, Confirmation of display accessory command.
1 4, Accessory 3 (relay).
2 s, Status of device:

0 for deactivated relay.
1 for activated relay.

3 m, Mode of operation (where m=0-7):
0 = Light mode.
1 = Dewpoint mode.
2 = Heat mode.
7 = Manual mode.

4 nn Threshold of darkness (in mpsas) for automatic mode of operation.
5 ttt Temperature (°C) used for dewpoint calculation.
6 hhh Humidity (%RH) used for dewpoint calculation.
7 ddd Dewpoint temperature (°C) used for dewpoint calculation.

␍␊ Carriage return (0x0d), Line feed (0x0a).

An example response to “A2x” is:
A,4,1,2,15,10,50,40,0␍␊
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8.7 Continuous reporting commands
The Continuous reporting features are somewhat experimental. A description of each feature follows:

Table 8.28: Summary of standard commands

Option Description

Reporting enabled Send a reading result every time it is available from internal computations. In
bright settings, a reading will be made available once per second, around 14mpsas,
a reading will be available depending on the sensor response which is between 60+
times per second and 60 seconds in very dark settings.

Ideal crossover firmware Changes the crossover of reporting from original (around 15mpsas to 12.32mpsas
which results in better resolution across the entire range of possible readings.

Reporting compressed Send the above enabled reading out in a compressed format without extra text.
Report un-averaged Sends the above reading out from the un-averaged accumulator. Normally the

averaged reading is sent.

Table 8.29: Continuous reporting command summary

Command Description

Yx Get status of the continuous reporting features.
YRx Enable continuous reporting.
Yrx Disable continuous reporting.
YCx Enable ideal crossover firmware code.
Ycx Disable ideal crossover firmware code.
YPx Enable continuous reporting compression.
Ypx Disable continuous reporting compression.
YUx Enable un-averaged continuous reporting.
Yux Disable un-averaged continuous reporting.

Table 8.30: Response of all continuous reporting requests

Column Example value Description

0 Y Confirmation of command.
1 r R = Continuous reporting enabled.

r = Continuous reporting disabled.
2 C C = Ideal crossover firmware code enabled.

c = Ideal crossover firmware code disabled.
3 p P = Continuous reporting compression enabled.

p = Continuous reporting compression disabled.
4 u U = Continuous reporting un-averaged readings enabled.

u = Continuous reporting un-averaged readings disabled.
Table continued on next page ...
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Table 8.30 – continued from previous page
Column Example value Description

5-6 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example response is:
YrCpu␍␊

0123456
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8.8 Setting Interval reporting parameters
For firmware feature ≥13, the SQM-LE is capable of sending timed interval reports. Each interval report is the same as
the reading request report except that the serial number (feature ≥14) is attached at the end so that numerous reporting
SQM-LEs can be distinguished from each other.
The format of the interval report is shown in table 8.53:

Table 8.31: Interval report

Column Example value Description

0 r Indicates that a reading is being returned.
2-8 ␣06.70m Reading in magnitudes per square arc second.

Leading space for positive value.
Leading negative sign (-) for negative value.
A reading of 0.00m means that the light at the sensor has reached
the upper brightness limit of the unit.

10-21 0000022921Hz Frequency of sensor in Hz.
23-33 0000000020c Period of sensor in counts. Counts occur at a rate of 460.8 kHz

(14.7456MHz/32).
35-46 0000000.000s Period of sensor in seconds with millisecond resolution. Determined

by dividing the above counts value by 460800.
48-54 ␣039.4C Temperature measured at light sensor in degrees C. The value is

averaged and presented every 4.3 seconds.
Leading space for positive value.
Leading negative sign (-) for negative value.

55-63 00000413 Serial number (8 digits). Each unit has its own unique serial num-
ber.

64-65 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example is:
r, 06.70m,0000022921Hz,0000000020c,0000000.000s, 039.4C,00000413␍␊

0123456789 123456789 123456789 123456789 123456789 123456789 12345

Interval reporting is available for sending timed reports to a listening server in the case where the SQM-LE IP address
will not be known, but the server IP address will be fixed. One such application is where an SQM-LE is connected via
a telephone/cell-phone based router to an Internet Service Provider. The server must have listening software running
similar Listing: ??:

Listing 8.1: Listener script for interval based reports
#!/usr/bin/perl

use IO::Socket;

while(1){

my $sock = new IO::Socket::INET (
LocalHost => '192.168.1.163', #IP address of this computer/server
LocalPort => '10002', #Port defined by XPort:Channel_1:Connection:Endpoint_Configuration:RemotePort
Proto => 'tcp',
Listen => 1,
Reuse => 1,

);
die "Could not create socket: $!\n" unless $sock;
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my $new_sock = $sock->accept();
while(<$new_sock>) {

($sec,$min,$hour,$mday,$mon,$year,$wday,$yday,$isdst)=localtime(time);
printf "%04d-%02d-%02d,%02d:%02d:%02d,",$year+1900,$mon+1,$mday,$hour,$min,$sec;
print $_;

}
close($sock);
}

To prevent reports being sent during daylight when the meter is saturated with light, a threshold value can be set.
Readings exceeding the threshold (dark) will be reported, low readings (too bright) will be suppressed.
Due to the construction nature of EEPROM, there is a limited number of times that this memory can be written to

before it becomes unreliable. In the case of the SQM-LE, the erase/write cycle is 1 million times. For this reason, it
is recommended that frequent parameter changes be done in RAM rather than in EPROM. Only set the parameter to
EEPROM when you want the unit to boot up with your setting. See following sections for how to set EEPROM or RAM.
Loading firmware clears resets the micro-controller effectively copying the EEPROM values into RAM.
Note: the above listener script is a simple receive only program. In a telephone mode system, the SQM-LE sends the

response to the listener, and nothing can send requests back to the SQM-LE. So it is advised that all settings be tested
before isolating the SQM-LE in remote locations. The other option to getting new requests back to the SQM-LE would
be altering the listener script to queue requests during the short time that the SQM-LE connects back to the listener
server.

8.8.1 Firewall settings at the listener side
The SQM-LE must be able to send interval reports directly to the listener script running on the listener server computer.
If there is an internet firewall blocking the incoming packets on the listener server, then a port should be opened. If you are
running the iptables on a Linux machine, here is an example when receiving from a machine at ip address 123.124.125.126
through port 10002:
Add the following rule to iptables:
iptables -A INPUT -p tcp -m tcp -s 123.124.125.126 --dport 10002 -j ACCEPT
and then run it to use the new rules.

8.8.2 XPort settings for interval reporting mode
The Ethernet adapter module (XPort) must be configured for sending interval based reports to a server. To set the
SQM-LE to know the listener IP address use a web browser to access the SQM-LE, just type in the IP address of the
SQM-LE into a web browser and you will be asked for a name and password, just hit enter (there is nothing set at
default). You will be given a XPort configuration screen. You can also do the same things with the Lantronix Windows
based “Device Installer” program included on the CD. Set the XPort as shown Table ??.
Note: The RemotePort is different than the typical 10001 to avoid problems with regular SQM-LE clients. Also, the

RemoteHost is set to the IP address of your listener server.

Table 8.32: XPort settings for interval reporting mode

Channel 1: Connection:
Active Connection:ActiveConnect = ”With Any Character”
Endpoint Configuration:RemotePort = 10002
Endpoint Configuration:RemoteHost = 192.168.1.145
Disconnect Mode:Inactivity Timeout: = 0:2(mins:secs)

If the modem takes a long time to connect then the timeout should be extended.
The Inactivity timeout should not exceed the interval time otherwise the unit may lock out other communications

requests. If this occurs, you can recover by way of the Lantronix device installer or Lantronix web interface by typing the
SQM-LE IP address into a web browser (hit enter on user name/password). Then set:

Unihedron SQM-LE Operator’s Manual - 20260307 91



8 Commands and responses

Channel1:Connection:Disconnect-Mode:Inactivity-Timeout=0:2(mins:secs),
then press OK, then “Apply Settings”.
If the Inactivity timeout is too short, a telephone modem connection system may not have enough time to send the

message before the XPort gives up.
If the Inactivity timeout is too long, then a telephone modem connection may stay active all the time resulting in

excessive connection costs.

8.8.3 Interval reporting period setting
Executing the command “P##########x” (note upper case “P”) sets the period of the timed interval reports to the
EEPROM and RAM for booting and immediate use.
Executing the command “p##########x” (note lower case “p”) sets the period of the timed interval reports to RAM

only for immediate use.
The units are seconds. For example, the command “p0000000360x” sets the reporting time to once every 360 seconds.

8.8.4 Threshold setting for interval reporting
Executing the command “T########.##x” (note upper case “T”) sets the threshold of the timed interval reports to
EEPROM and RAM for boot and immediate use.
Executing the command “t########.##x” (note lower case “t”) sets the threshold of the timed interval reports to

RAM for immediate use only.
The units are magnitudes

arcsecond2 . For example, t00000016.00x limits reporting to values only over 16.00 magnitudes
arcsecond2

8.8.5 Interval setting response
Either making the request “Ix” (note upper case “I”) or any request to set the interval report setting produces the following
response shown in table 8.54:

Table 8.33: Response of viewing or setting interval reporting parameters

Column Example value Description

0 I Interval settings from EEPROM and RAM are being returned.
2-12 0000000360s Interval period that was set into EEPROM.
14-24 0000300360s Interval period that was set into RAM.
26-37 00000017.60m Threshold value that was set into EEPROM.
39-50 00000017.60m Threshold value that was set into RAM.
51-52 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example response is:
I,0000000360s,0000000360s,00000017.60m,00000017.60m␍␊

0123456789 123456789 123456789 123456789 123456789 12
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8.9 Simulation commands
The following simulation commands help to determine the results of mag

arcsec2 readings derived from the light and temperature
sensors.
When using the Simulation mode of the SQM-LE, make sure that nothing else interrupts the sequence of readings such

as external programs reading from the SQM-LE, or settings of Interval reporting inside the SQM-LE. To read the internal
simulation values, issue the sx command, the response is shown in table 8.55:

Table 8.34: Response of request for internal simulation values

Column Example value Description

0 s Confirmation of the command.
1 , Separation character.
2-12 0000000360c Number of counts.
13 , Separation character.
14-24 0000000360f Frequency in Hz.
25 , Separation character.
26-37 0000000244t Temperature ADC value as seen by the CPU. See Equation 8.1 .
38-39 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example response is:
s,0000000360c,0000000360f,0000000360t␍␊

0123456789 123456789 123456789 12345678

To convert raw temperature value to degrees C:

DegC =
raw×3.3

1024 − 0.5

0.01
(8.1)

To convert degrees C value to raw temperature:

raw =
(DegC × 0.01 + 0.5)× 1024

3.3
(8.2)

To set the internal simulation values and read the calculated response, issue the S…x command as detailed in Table
8.56. The result of that command is shown in Table 8.57.

Table 8.35: Request simulation (S....x)

Column Example value Description

0-1 S, Initiation of Sx command.
2-11 0000000360 Simulated counts.
12 , Separation character (can be anything except x).
13-22 0000000360 Simulated Frequency in Hz
23 , Separation character (can be anything except x).

Table continued on next page ...
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Table 8.35 – continued from previous page
Column Example value Description

24-33 00244 Simulated Temperature ADC value. See Equation 8.1 .
34 x Terminating character.
35-36 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example command is:
S,0000000360,0000000360,0000000360x␍␊

0123456789 123456789 123456789 123456

Table 8.36: Response of setting simulation values (S...x)

Column Example value Description

0-1 S, Confirmation of S...x command.
2-13 0000094000c, Simulated counts.
14-25 0000000000f, Simulated frequency in Hz.
26-37 0000000245t, Simulated temperature ADC value. See Equation 8.1 .
38-39 r, Beginning of calculated readings.
40-47 ␣18.04m, Calculated mag

arcsec2 .
48-60 0000000000Hz, Frequency used for calculation.
61-72 0000094000c, Counts used for calculation.
73-85 0000000.204s, Calculated period from counts.
86-92 ␣029.0C Temperature used for calculation.
93-94 ␍␊ Carriage return (0x0d), Line feed (0x0a).

An example response is:
S,0000094000c,0000000000f,0000000245t,r, 18.04m,0000000000Hz,0000094000c,0000000.204s, 029.0C␍␊

0123456789 123456789 123456789 123456789 123456789 123456789 123456789 123456789 123456789 1234
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9.1 Electrical connection
An AC/DC adapter is provided. The SQM-LE uses a voltage regulator to bring the incoming DC voltage down to 3.3VDC.
The lowest voltage at the input should be 4.5VDC (3.3 + 1.2VDC). Higher voltages above 6VDC will cause heating on
the regulator and thermal shutdown in high ambient temperatures.
For remote applications, a deep-cycle (Lead Acid) 6VDC battery can be used.
The SQM-LE unit is NOT protected against over-voltage (above 20V) or reverse polarity voltage.

9.2 Mechanical installation
Unihedron sells an enclosure that is suitable for mounting either the SQM-LE, SQM-LU, SQM-LR, SQM-LU-DL into.
You can read more about it, including plans to build your own at www.unihedron.com/projects/sqmhousing/ .

Figure 9.1: Housing

9.2.1 Cover selection
If the unit is to be mounted in exposed location, we recommend the Unihedron plastic weatherproof housing with glass
window plate, or an acrylic dome. Acrylic domes will last 2-3 years but eventually weather on the surface. It is not clear
that this will affect the reading much. The best test would be to swap a weathered and new one back and forth when
changing one out. Presumably the main consideration would be to keep the domes clean every so often and to make sure
that the mounting plane is painted black to that it doesn’t reflect light back to the inside of the dome and then back into
the meter.
Source of scrylic domes: www.globalplastics.ca/domes.htm

9.2.2 Cover calibration
Since the meter is not weather-proof, it must be protected in some way from the elements. The Unihedron meter housing
or a plastic dome is recommended. This will reduce the incoming light (approximately 15-20%).
Because a covering will reduce the incoming light, the resultant reading will be darker (higher mag

arcsec2 value). The offset
determined by a simple light experiment should be subtracted from the reading.
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The light calibration offset is like a starting point for readings, and since the cover glass makes readings darker, the
offset should compensate by starting a brighter value.
Apply the cover subtraction offset as a negative value, i.e. if you measured 16.60 outside the covering, then 16.75 under

the dome, then an offset of -0.15 should be applied to all readings.
An example using the UDM software; if your offset is -0.15 and your factory calibrated light calibration offset is 19.92

then you should change the light-calibration-offset on the calibration-tab to 19.77. European users will see and use a
comma instead of a decimal point (eg. 19,77).

Figure 9.2: Example cover calibration

9.2.3 Cover maintenance
Keep the covering clean of dust, water, ice, and bird droppings.
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10.1 XPort settings
The XPort Ethernet interface has been programmed with the following default settings so that it can communicate with
the SQM-LE micro-controller:

Table 10.1: Default XPort settings

Setting description Value

Configurable pins,
CP2:

HW Flow Control In (CTS from microcontroller)

Channel 1,
Serial Settings,
Baud rate:

115200

Channel 1,
Serial Settings,
Flow control:

CTS/RTS Hardware

If for some reason these settings are altered, they can be restored using the Lantronix Device Installer under Windows.
Or the UDM program (select Firmware, XPort defaults).

10.2 ARP method
Use the arp method to reset the Xport Ethernet module back to DHCP from a fixed IP address.
The arp method is superior to the LDI method as the arp method will find devices that the LDI cannot find and

have had their IP addresses assigned away from DHCP. Some extra arp method details from the XPort manufacturer are
defined in the document, Xport-arp-method.pdf , on USB drive in the directory:
/SQM-LE/reference/
You must first assign a temporary IP address on your system (shown as yyy below), pick an free intended address that

is in you network subdomain, and example for yyy might be 192.168.1.109

For Windows

1. Open an admin command prompt in Windows, Start–Programs–Accessories, then right click on the Command
prompt program and select “run as administrator”

2. To find the IP address of your Windows computer, use the ipconfig command.

3. In a Windows command prompt, create an entry in the host’s ARP table using the intended IP address and the
hardware address of the unit (on the product label on the bottom of the unit) as follows:
arp -s yyy 00-20-4a-xx-xx-xx

4. Open a Telnet connection to port 1. The connection fails quickly, but the unit temporarily changes its IP address
to the one designated in this step:
telnet yyy 1
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5. Open a Telnet connection to port 9999, and press Enter within five seconds to go into Setup Mode. If you wait
longer than five seconds, the unit reboots:
telnet yyy 9999

6. Select 0 (Server Configuration) and follow the prompts until you get to IP address.

7. Enter the new IP address, subnet mask, and gateway (if applicable).

8. Select 9 to save and exit Setup Mode. The unit performs a power reset.

10.2.1 For Linux
1. Open a superuser command prompt in Linux.

2. To find the IP address of your computer, use the ifconfig command.

3. In the command prompt, create an entry in the host’s ARP table using the intended IP address and the hardware
address of the unit (on the product label on the bottom of the unit) as follows:
arp -s yyy 00:xx:xx:xx:xx:xx

4. Open a Telnet connection to port 1. The connection fails quickly, but the unit temporarily changes its IP address
to the one designated in this step:
telnet yyy 1

5. Open a Telnet connection to port 9999, and press Enter within five seconds to go into Setup Mode. If you wait
longer than five seconds, the unit reboots:
telnet yyy 9999

6. Select 0 (Server Configuration) and follow the prompts until you get to IP address.

7. Enter the new IP address, subnet mask, and gateway (if applicable).

8. Select 9 to save and exit Setup Mode. The unit performs a power reset.
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11 Firmware upgrade
See the UDM “Firmware tab” section on page 63 for instructions on updating the firmware in the SQM-LE.

11.1 Details
The SQM-LE contains a micro-controller that is equipped with a boot-loader mechanism which is enabled for a few
seconds after reboot/reset.
Intel hex strings sent to the unit are used to overwrite program memory. The following link contains a thorough

description of the Intel Hex format: http://en.wikipedia.org/wiki/.hex
The basic requirements for firmware uploading are:

1. Reset micro-controller by sending the hex character 0x19
2. Within a few seconds, send the first Intel hex record. The colon “:” character indicates the beginning of an Intel

Hex record.
3. Wait for a response of “Ok” followed by “CR LF” which indicates that the record was processed properly.
4. Continue sending records and waiting for the acknowledgement.
5. The unit will reset on its own when no more records have been sent for a few seconds.
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12 Calibration
The SQM-LE is factory calibrated and a sheet of the calibration values was provided with the unit. Contact Unihedron
with your unit’s MAC address if you need a copy of the original calibration sheet.
Some possible reasons for recalibration are:

1. A new covering/housing is being used besides the small case that the unit was shipped with.
2. A regular maintenance program is desired. There is no great need for this as the SQM-LE has no analog components.
3. Compensation for aged housing, if a plastic dome is used that might have degraded over time.
4. Replaced lens or changed field of view for experimental reasons.

12.1 Recalibration
There is no easy way to perform in-field recalibration. It is recommended to send the unit back to Unihedron for proper
calibration. There is a nominal fee for recalibration and shipping. Please contact Unihedron for details.

12.2 Light calibration
The sensor must have a reference point for an amount of light against the signal produced. It is not recommended that
this be done after factory calibration and relied upon since an improper setup will result in non-standard results.
A fluorescent light or green LED is used to simulate the spectrum that the meter would see during the night sky. A

light meter is used to adjust the light reading to 13.5 fc at the place of the SQM-LE. The light calibration routine inside
the SQM-LE expects to see this value.
The light that the SQM-LE and light meter see must be coming from an evenly lit surface.
The “light calibration” command can be sent to the unlocked SQM-LE to set the calibration value.

12.3 Dark calibration
The optical sensor in the SQM-LE produces a reading even when totally dark. This “dark level” reading must be
determined so that the meter can compensate for it.
The method of dark calibration is simply to prevent any light from entering the meter then execute a “dark calibration”

command to the unit. A darkroom bag is one way to prevent light from entering the unit.
The optical sensor provides timed pulses depending on the amount of light entering. In a dark environment the pulses

will be long. The meter has a timeout of 300 seconds, so the dark calibration will take at least 5 minutes (300 seconds)
to perform.
Place the unit in a dark environment and monitor the timed readings (rx reading request) until they are consistent,

normally the value is in the 80-300 second range, then execute the “dark calibration” command.

12.4 Confirmation
Once the calibration has been done, you should be able to get a light reading from the unit at the calibration light level
of the same value as the value printed on your calibration sheet in the “Calibration offset” field, Normally this field has
a value of 8.71 mags/arcsec2.
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13 Troubleshooting

Table 13.1: Reading seem too bright

Problem The meter reads values that are brighter than expected.
Cause A light may be shining into the field of view of the meter.

Or, the IR filter may have fallen out of the lens.
Solution Ensure that there are no extra sources of visible light in the field of view of the meter. Also, some

infrared security cameras emit enough light in the spectrum that the meter will pick up.

Inspect lens for IR filter. You should see a light blue colour inside the lens.

Table 13.2: Reading is 0.00mpsas

Problem The meter reads values of 0mpsas.
Cause In bright light over about 6mpsas (even indoors) the meter saturates and will produce a reading

of 0mpsas.
Solution Test the meter in a darker setting or place a cover over the meter while doing indoor testing.

Note: in complete darkness (like a photo-darkroom), the meter may timeout and also produce
strange readings.

Table 13.3: Cannot Find UDM software

Problem Microsoft Edge cannot find UDM software on the CD. Error “Can’t reach this page”.
Cause Microsoft Edge has protections in place to hide file lists on remote drives.
Solution Use the File Manager to navigate the CD to the Windows directory then install from there. Or,

get the latest Windows version of UDM from the Unihedron website:
unihedron.com/projects/darksky/cd/Windows/

Table 13.4: Meter seems too hot

Problem The reported temperature seems to be too hot.
Table continued on next page ...
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13 Troubleshooting

Table 13.4 – continued from previous page
Cause The SQM-LE contains a webserver (XPort Ethernet module) requires a great deal of power which

raises the internal above ambient by 20-30C. This is not really a problem because the SQM-LE
is rated for a very high temperature (85°C), and the light sensor readings are compensated for
temperature.
The maximum operating temperature of all the components inside the SQM-LE is 85C.
We have been operating the unit inside a housing and the unit temperature has reached 65C on
many occasions without affecting operation.
The light sensor readings are compensated for temperature fluctuations. The temperature sensor
located very close to the light sensor.

Solution No action is required.

Table 13.5: Readings do not get dark enough

Problem The reported reading does not seem get dark enough.
Cause Ensure that man-made light is not entering the lens. Some people have thought that the LEDs

from the PoE may be entering into the lens by way of reflections inside the weatherproof housing.
We have not been able to prove this with testing ourselves.

Solution Make sure that the PoE LEDs are facing towards the bottom of the weatherproof housing.
You can also try to use black tape to cover the LEDs.

Table 13.6: Error 404 when trying to reconfigure Ethernet module

Problem Error 404 when trying to reconfigure Ethernet port using the web interface
Cause The interface pages may have been overwritten by a “tftp put” to the wrong remotefile.

The default XPort Ethernet reconfiguration web interface occupies at least 3 blocks of 64k (WEB1-
WEB4). WEB5-6 could be used for custom application pages (like test.html) which take up to
128K.

Solution Get the web interface from Lantronix for the XPort-03, then install using the following tftp com-
mand:
for Windows:
tftp-i <ip adress> put xpt_webm_1602.cob WEB1

for Linux (using tftp-hpa):
tftp < ip adress > -m binary -c put xpt_webm_1602.cob WEB1

Table 13.7: Meter will not respond

Problem Unit will not respond to ping or any network activity.
Cause Ethernet interface did not properly negotiate an IP address when starting up.

Table continued on next page ...
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Table 13.7 – continued from previous page
Solution Power check:

Check connection lights on SQM-LE Ethernet port. No lights after power up could indicate a
faulty power connection.
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Network check:
1. Re-cycle power on SQM-LE so that its Ethernet port can re-negotiate an IP address.
2. Use the Lantronix Device Installer program for Windows (supplied on the USB stick in the
directory: /SQM-LE/windows/ . This will identify all SQM-LE units on the attached network.
3. It is possible that a firewall may be running, especially on Windows Vista. Try shutting off the
firewall temporarily.
4. Use the red crossover cable (supplied) to connect the SQM-LE directly to the computer then
retry the Lantronix Device Installer.
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
To reset the Xport module back to DHCP, see the ARP method on page ??

Table 13.8: Socket error 10051

Problem Windows reports “Socket error #10051”
Cause The network is unreachable. Which means that the device likely works properly, but for some

reason (like domain restrictions) the router or network settings do not allow communication to
that device.

Solution Use the arp technique described in Table ?? to set the IP address to a free address in your network.

Table 13.9: Ping but no readings

Problem Unit can be pinged but readings are not returned.
Cause The default communication settings between the XPort micro-controller may have been changed.
Solution Use the Unihedron Device Manager (supplied software), select the Firmware tab, then press the

XPort defaults button. This will set the Ethernet module parameters like those defined in section
8 (Default settings) for proper baud rate, etc.

Table 13.10: Ping but cannot be found by UDM

Problem Unit can be pinged, but UDM cannot find it.
Cause UDM requires that port 30718 is open for discovery of the SQM-LE .
Solution Enable port 30718 in your firewall or router.

Table 13.11: No SQM-LE connection found by UDM

Problem UDM cannot find SQM-LE.
Cause It could be that the XPort module of the SQM-LEhas been set to the same IP address as another

device on yout network.
Table continued on next page ...
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13 Troubleshooting

Table 13.11 – continued from previous page
Solution Disconnect the other device, and use a browser or ARP method to change the defined address to

something else or to DHCP. Note that some browsers no longer support JAVA that is required
for older XPort modules inside the SQM-LE. The PaleMoon browser still supports JAVA as of
20230517

Table 13.12: No SQM-LE connection found when using Apple Lightning Ethernet adapter

Problem UDM cannot find SQM-LE when using the Apple Lightning Ethernet adapter.
Cause Some Ethernet adapters work exclusively and cannot work with Wifi enabled.
Solution Disable the WIFI and retry finding the SQM-LE connection

Table 13.13: Lantronix Device Installer update problems

Problem Lantronix Device Installer does not show updates.
Cause The browser feature of the “Lantronix Device Installer” appears to be not as capable as modern

web browsers.
Solution Making changes to your SQM-LE Xport Ethernet module can be done by directly accessing it with

a web browser. Go to the URL of the IP address of your browser, no username or password are
required, just hit enter when asked.

Table 13.14: Reading errors reported

Problem SQM-Reader version 1.2 and earlier while reports reading errors while UDM correctly reports text
strings.

Cause Regional settings in Windows may be set for the European standard for decimal separators as
commas “,” instead of periods “.”.

Solution Upgrade to a newer version of SQM-Reader by Knightware or modify your regional settings to use
periods as the decimal point separators.

Table 13.15: UDM: Continuous readings on Mac stop when the computer goes to sleep

Problem Continuous readings on Mac stop when the computer goes to sleep
Cause Some Mac computers/OS will go to sleep and shut down the Ethernet connection.
Solution Alter the power settings in the Mac preferences to not shut the Ethernet port off, or change the

sleep time to NEVER.

Table 13.16: UDM: Continuous readings fail when triggering too fast

Problem Continuous readings fail when triggering too fast
Table continued on next page ...
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Table 13.16 – continued from previous page
Cause When one reading fails to be obtained, the UDM rety method tries three times. If this is too slow

for the trigger time, the sampling eats into the next trigger time.
Solution Set trigger time to 6 seconds or longer.

Table 13.17: Darkroom-bag readings incorrect

Problem Meter readings from inside a darkroom-bag are not dark enough or do not change.
Cause In completely dark environments, the meter cannot collect enough light to even resolve one reading.
Solution Test the meter in natural darkness outside at night.

Table 13.18: UDM shuts down after starting

Problem UDM shuts down after starting
Cause An improper startup option may be stored.
Solution Remove the [Startup options] section from the config file using a text editor. Mac and Linux stores

the configuration in udm.cfg, Windows stores the configuration in udm.ini . See 7.3
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14 Glossary

Table 14.1: Glossary of terms

ADC Analog to Digital Converter. A device usde to convert an analog signal into a digital value.
CCD Charge coupled device is a type if image sensor.
DHCP Dynamic Host Configuration Protocol (DHCP) is a network application protocol used

by devices (DHCP clients) to obtain configuration information for operation in an IP network.
Routers equipped with DHCP are capable of assigning an IP address to the SQM-LE

EEPROM Electrically Erasable Programmable Read Only Memory is a type of memory that retains its
contents after the power has been removed. This type of memory has a limited write/erase cycle
as well as a lifetime for data retention. In the SQM-LE, the parameters in the micro-controller
can be written 1 million times and last for 100 years.

Firmware The program that resides inside the device. In the case of the Unihedron SQM products, it is
the software runs the device including reading and reporting the light values.

FITS Flexible Image Transport System is an open standard defining a digital file format useful for
storage, transmission and processing of scientific and other images.

GPS Global Positioning System. A GPS receiver may be connected to a computer to allow UDM to
integrate the location information into the logged data. See UDM for mode details.

mpsas Magnitudes per square arcsecond. The unit of measurement reported by the SQM.
NMEA National Marine Electronics Association data format that the GPS receiver produces.
SQM-LE Sky Quality Meter with lens and Ethernet connectivity.
IP address Internet Protocol address is the numerical identification of a device on a network The SQM-

LE, by default, has an assignable IP address, but can also be set to have a fixed IP address.
MAC address Media Access Control address is the hardware address assigned to Ethernet enabled devices.

This address is usually unchangeable.
PoE Power over Ethernet is a system used to inject power into an Ethernet cable which can be

split out for powering devices.
RAM Random Access Memory. Temporary memory that only retains data while power is applied.
SQM-LE Sky Quality Meter with Lens and Ethernet connectivity
UDM Unihedron Device Manager is software used to access the SQM series of meters.
XPort Lantronix Ethernet module. The SQM-LE contains this XPort module to link the SQM-LE ’s

internal microcontroller to the Ethernet port.
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